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1 Summary of changes in Commissioning
UltraSite EDGE BTS

The following changes have taken place in the Commissioning UltraSite EDGE
BTS document.

. Mini Outdoor information added in Section Connecting LMP cable for
commissioning

. Section Using Site Wizard in Mini Outdoor commissioning added to the
document

. Section List of instructions for BTS configuration using MMI software
added to the document
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2 Overview of commissioning the BTS
Before you start

Before commissioning, the physical installation of the BTS (units, cabling,
antennas, and radios) must be complete.

Steps

1. Connect the LMP cable.

2. Power on the BTS.

3. Set the BOIx unit 13 MHz clock.

4. Install the BTS Manager.

5. Install the UltraSite BTS Hub Manager.

6. Install other Transmission Manager as required.

7. Commission the BTS.
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3 Preparing to commission

3.1 Connecting LMP cable for commissioning

Before you start

There are two options for connecting to the LMP port within the Mini outdoor
BTS:

1. Connecting directly to the BOIx unit LMP connection, or

2. Connecting to the BTS external interface point.

Summary

The LMP cable connects the PC running the BTS Manager software to the BOIx
unit in the BTS.
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Figure 1. LMP cable

Table 1. LMP cable connector pin order

BTS end, D9 male, pin
number

PC end, D9 female, pin
number

PC end, D25 female,
pin number

2, LMP in 3, transmitted data 2, transmitted data

3, LMP out 2, received data 3, received data

5, ground 5, ground 7, ground

PC end,
D9 female

BTS end,
D9 male

5 4 3 2 1

9 8 7 6

1 2 3 4 5

6 7 8 9

DN03439708
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Steps

1. Remove the protective cover from the LMP port on the BOIx unit for
GSM/EDGE connection.

2. Connect the D9 female connector to the PC.

3. Connect the D9 male connector to the LMP port on the BOIx unit for
GSM/EDGE connection.

Or

If you are commissioning Mini outdoor cabinet, you can also:

4. Connect the D9 connector to the BTS external interface point.

3.2 Technical data for the LMP cable

The LMP cable provides a connection between the laptop computer and the LMP
port on the CCUA.

Figure 2. LMP cable specification
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Figure 3. LMP cable

Table 2. Connector pin order

BTS end, D9 male, pin
number

PC end, D9 female, pin
number

PC end, D25 female,
pin number

2, LMP in 3, transmitted data 2, transmitted data

3, LMP out 2, received data 3, received data

5, ground 5, ground 7, ground

PC end,
D9 female

BTS end,
D9 male

5 4 3 2 1

9 8 7 6

1 2 3 4 5

6 7 8 9

DN03439708
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3.3 Powering on the BTS

Before you start

Ensure that all internal BTS components are properly installed.

Summary

Steps

1. If the Mains power has been switched off,

Then

Check the ADUx circuit breakers.

Verify that all the ADUx unit circuit breakers are switched off.

2. If BTS power supplies are switched on,

Then

switch the power supplies off.

3. Switch the Mains breaker on.

4. Switch the ADUx unit breakers on.

5. Switch the BTS Power supplies on.

6. Check the BTS units for power.

Observe the LED lights of the BTS units and ensure that power is supplied.
If the LED lights are not illuminated, troubleshoot the affected units.
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4 Remote BTS Manager Setup

4.1 Remote BTS Manager setup

Before you start

This document explains how to configure and use the Remote BTS Manager
feature. It provides a high-level view of the Remote BTS Manager connection. It
also explains how to configure the NMS/OSS, BSC, and BTS, which are required
for a connection to a remote BTS.

The operations available in Remote usage of BTS Manager depend on whether
the user is set up with full priviledges or not. This depends on the Windows user
group to which the user belongs.

If the user has full privileges, then Remote BTS manager will not allow:

. Disable Abis

. Commissioning

. SW Download

. BCF block/unblock

. Sector block/unblock

. TRX block/unblock

If the user has 'Read Only' privileges, then Remote BTS manager will not allow:

. Commissioning

. Software Update/Replace/Use Current

. Object Reset/Block/Unblock

. Enable/Disable Abis
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. RTC Configure

. Clock Control

. Setting of IDD information

. Running tests such as TRX test and Loop Tests

. Writing to Site Specific Notepad

. Sending of BCCH Carrier

. Updating Abis Allocation

. Setting BTS password

The following diagram provides a high-level view of how the BTS Manager
connects to a remote BTS. It also shows Local Connection mode.

Figure 4. BTS Manager - Local and remote access

Steps

1. Set up the NMS/OSS.

Use NMS2000 software version T12 or later or NetAct 3.1 or later.

Remote
BTS

Manager

NMS/OSS

Q1 over X 25/LAN
(using GCS)

Local
BTS

Manager

Q1
over
Abis

Note: either a Local or a
single Remote connection
to a BTS is possible at

a time

BTS

O
M
U

T
R
X

Q1 over
TCP /IP LAN
(using GCS)

Q1 over
LMB

(using GCS)
BSC
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a. Log on to NMS/OSS.

b. Verify that the configuration file $OMCPOLICE/osi/ouorapmx.cf
describes the NOD and RET applications.

Note

To locate these two files, check the Remote BTS Manager and Node sections
of the BSC with which you are working.

c. Verify that NMS/OSS has ornuser set up in the user profiles:

From the Top Level User Interface (TLUI) menu, select Utils,
System mgmt, User profiles, and Users.

Note

If the user profile does not exist, you must create it according to NMS/OSS
instructions.

2. Set up the BSC.

Use the BSC with software version S10.5/S10.5 ED or later.

a. Log on to the BSC.

b. Verify that the BSC with which you are working has the NOD and
RET applications. These applications must be in UNL-ENA state.

Note

These applications must be in UNL state to log on to remote access.

At the prompt, enter the MML command ZQDI. See also the
following example.

DN05168119
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Figure 5. Example

In this example, a BSC with C-Number 55423 is used. Notice the
highlighted RET and NOD applications.

3. Set up the BTS

The BTS must be running software version CX3.3 or later. No specific
setup for the BTS is required. The BTS, which is identified by its BCF ID,
must be switched on and commissioned (Abis O&M Link up and running).

To connect remotely to the BTS Manager, the BTS Manager must not be
connected locally to the same BTS.

4. Set up the BTS Manager.

Use the BTS Manager with SiteWizard 5 for the remote connection.

DX 200 BSC5 2002 - 11 - 26 15:08:26

LOCAL OSI APPLICATION DATA

AE- NAME APPL NET ADDR STATE UNIT FAM ID PROC ID
—————————————— ———— —————— ————— ———————— ————— —————

BSC055423A CMISE LOCNMS LOC - ENA OMU 021FH 0000H
BSC055423F VFS LOCNMS UNL - ENA OMU
BSC055423VT VTP LOCNMS UNL - ENA OMU
BSC055423EHA CMISE LOCNMS LOC - ENA OMU 02B1H 0000H
BSC055423NOD TPU LOCNMS UNL - ENA OMU 02AFH 0000H
BSC055423RET TPU LOCNMS UNL - ENA OMU 0229H 0000H
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a. Verify that the GCS Installation Release 5 software is properly
installed on the computer.

The GCS software is used to establish the BTS Manager connection
to a BTS, both local and remote.

Note

If the GCS software is not installed, you can install it during SiteWizard 5
installation.

b. From the Connection menu, select Connection - Connect to launch
the Nokia GCS Connection Tool.

For more information, see the Nokia GCS Connection Tool online
help.

Note

You can also set up a connection separately using CLI with sobriquet.

Once established, the details are recorded in the GCS database and
ready for use at a later date.

c. Set up the BTS connection.

i. Make sure you have the Database Property sheet open.

ii. Click Connections, and then select Add ....

iii. Enter a name for the connection.

iv. Select BTS Connection as the type of connection. The
following connection definitions appear:
. Network parameters
. BSC parameters
. BTS parameters
. Optional parameters

v. Select Network Parameters. Click Properties, add the
following parameters, and click OK:

Parameter Enter ...

HOST NAME Host IP address

PORT 7878

vi. Select BSC Parameters in the Connection Definition area.
Click Properties, add the following parameters, and click OK:

DN05168119
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Parameter Enter ...

USER NAME ornuser

PASSWORD Password for the ornuser user profile in
the NMS/OSS

PROTOCOL 1

BSC ID C-Number of the BSC

BUS NUMBER 0

vii. Select BTS Parameters in the Connection Definition area.
Click Properties, add the following parameters, and click OK:

Parameter Enter ...

BCF ID BCF ID of the BTS

PORT 1

Note

It is not necessary to modify the Optional Parameters.

viii. From the Database Property tab, click Save.

d. Create a node using the Nokia Connection Tool.

i. Select Nodes on the Database Property Sheet; then click Add.

ii. Enter the following information:

Parameter Enter ...

CONNECTION NAME Name given to the connection

NODE NAME Name of the node

NODE CLASS Q1 Node

NODE DEFINITION Q1 Node

Q1 ADDRESS 4001

Note

All other parameters are optional.
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e. Enter the following sobriquet command line argument to launch the
BTS Manager using CLI:

BTSManager -sobriquet
"aNodeNameYouHaveDefinedInNokiaConnectionTool"

Note

This command attempts remote connection straightaway.

f. Or, initiate the BTS Manager Remote Connection without the
command line argument.

i. From the Connection menu, select Disconnect.

ii. Select Connect to open the Nokia GCS Connection Tool.

Note

The Direct property page must be open with existing connections displayed.

iii. Select the connection you want to use, enter the Q1 address,
and click Connect.

Note

It is also possible to define new connections and nodes using the Database
property sheet.

Tip

Check the following if the Remote Connection fails:
. Is the LAN running?
. Is the GCS Installation OK?
. Are the NMS/OSS and BSC up and running? Have they been

set up properly?
. Have the connection and node in GCS Connection Tool been

properly configured (in accordance with the System setup)?
. Is the BTS connected to the BSC?
. Is the Abis link up and running (is the BTS switched on)?
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. Does the targeted BTS have the O&M software that supports
Remote BTS Manager?

. Is there already a Local or Remote connection to the targeted
BTS (in which case, the BTS Manager displays a message
box indicating that the BTS already has an active BTS
connection)?

4.2 Rules for EDAP transmission connections

Summary

It is recommended that the same timeslot allocation be used for the BSC and
BTS. If required, the first EDAP timeslot at the BSC can be different than the first
EDAP timeslot at the BTS. Cross connections are allowed, but it is recommended
that the whole PCM frame or the n*64 cross connection complies with the ITU-T
G.796 (Characteristics of a 64 kbit/s Cross-Connect Equipment with 2048 kbit/s
Access Ports, Chapter 2.1) standard in respect to maintaining octet sequence
integrity of signals being cross connected. The following precautions help to
maximise performance:

. EDAP and the TRXs that are tied to the EDAP (including traffic/master
and signaling channels) must share the same physical Abis connection
route. It is also recommended that PCM frames have octet sequence
integrity, which can be achieved using one of the following methods:
. Using 1-3 PCM lines that perform according to G.796. If BTS

capacity requires several PCM lines, a normal network delay
variance between the PCM lines does not impact performance.
EDAP pool and the TRXs tied to it have to locate on a single PCM.
Example 4+4+4 configuration: TRX 1-4 and their EDAP(s) on
PCM1, TRX 5-8 and their EDAP(s) on PCM2, and TRX 9-12 and
their EDAP(s) on PCM3.

. Using fractional E1, n*64k connection that complies with G.796.

. The EDAP pool and TRXs tied to it must have a connection made within a
single PCM or a single or multiple n*64k connection inside one PCM that
comply with the G.796 in the respect of octet sequence integrity. This
structure must be maintained throughout the network.

. If the PCM line does not fulfill the octet sequence integrity requirement as
specified in ITU-T G.796, a maximum of +/- three PCM frame delay
between timeslots is tolerated when BSC software S10.5 ED CD1.2 or
newer is used.
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Steps

1. Use a telecom analyzer, such as Agilent E7580A or HP 37722A, at the
BSC end.

2. Measure from the line that comes to the E/T interface.

3. Define all time slots that are connected through the network to the
BTS as transmit time slots in the Measurement Equipment view.

Note

This also applies to fractional time slot blocks as well.

4. Verify that the Measurement view does not contain/use any time slots
used for any other BTS (or other purpose).

5. Loop the signal back with the FXC unit at the BTS using the Loop-to-
Interface command.

6. Define the same time slots as receiving time slots in the Measurement
Equipment view.

7. Start the pseudorandom (PRBS) test pattern.

If the measurement result for the 2Mbit/s line proves that the line is clean
of errors during the short measurement cycle (for example, 15 minutes),
the line must be free of time slot phase shifts, and the G.796 is fulfilled.

4.3 Installing BTS Manager

Before you start

Before installing BTS Manager, check the following system requirements.

Table 3. System requirements for BTS Manager

System component Requirement

Computer Intel® Pentium®-compatible PC

DN05168119
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Table 3. System requirements for BTS Manager (cont.)

System component Requirement

Operating system Microsoft® WindowsTM 2000 (Service Pack 3)

Microsoft® WindowsTM 2000 Server

Microsoft® WindowsTM XP

Microsoft® WindowsTM 2003 Server

Processor minimum 300 MHz (recommended 500 MHz or more)

System memory 128 MB recommended or according to installed operating system

Monitor minimum SVGA with 800 x 600 resolution (recommended 1024 x 768
resolution)

Hard disk 10 MB free space exclusively for each Node Manager installation
(recommended hard disk space 200 MB)

Local connection 9-pin serial port in the PC and LMP cable

Remote connection Network adapter with connection to DCN

Accessories CD-ROM drive

Pointing device: mouse, trackball, touch pad or equivalent

Windows-compatible printer (optional)

Summary

BTS Manager and the other related management applications are delivered on the
SiteWizard CD.

Software updates are delivered via Nokia Online Services (NOLS).

Steps

1. Start Windows.

2. Insert the installation CD-ROM into the CD-ROM drive.

3. Wait a few seconds.

If the Setup program is not launched automatically, double-click the CD-
ROM drive icon in the My Computer window to open the CD-ROM disk.
Double-click the Nokia SiteWizard5.msi program icon in the window.

4. Follow the instructions displayed in the Setup program.

The Setup program copies the BTS Manager files. At the end of the
procedure, it notifies you that the setup is complete.
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4.4 Installing UltraSite BTS Hub Manager

Before you start

Before installing UltraSite BTS Hub Manager, check the following system
requirements.

Table 4. System requirements for UltraSite BTS Hub Manager

System component Requirement

Computer Intel® Pentium®-compatible PC

Operating system Microsoft® WindowsTM 2000 (Service Pack 3)

Microsoft® WindowsTM 2000 Server

Microsoft® WindowsTM XP

Microsoft® WindowsTM 2003 Server

Processor minimum 300 MHz (recommended 500 MHz or more)

System memory 128 MB recommended or according to installed operating system

Monitor minimum SVGA with 800 x 600 resolution (recommended 1024 x
768 resolution)

Hard disk 10 MB free space exclusively for each Node Manager installation
(recommended hard disk space 200 MB)

Local connection 9-pin serial port in the PC and LMP cable

Remote connection Network adapter with connection to DCN

Accessories CD-ROM drive

Pointing device: mouse, trackball, touch pad or equivalent

Windows-compatible printer (optional)

Summary

UltraSite BTS Hub Manager and the other related management applications are
delivered on the SiteWizard CD.

Software updates are delivered via Nokia Online Services (NOLS).

Steps

1. Install General Communication Service (GCS).

SiteWizard automatically checks for the presence of GCS. If it is not found
on the system, SiteWizard installs it if selected from the Program Selection
window:

DN05168119
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Figure 6. Program Selection window

Note

To upgrade GCS from a previous version, see the SiteWizard Readme.txt
file or the GCS Readme.txt file for detailed instructions.

2. Start Setup by running setup.exe from your CD-ROM drive.

If AutoRun is set in your Operating System, setup.exe starts once the
SiteWizard CD is inserted into the CD-ROM drive.

3. Follow the instructions in the installation program.
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Note

The XML parser is automatically set by the Operating System. If you
experience any problem while saving XML files from the Hub Manager,
manually install the XML parser from the accessories folder on the SiteWizard
installation CD. The XML parser is included on the SiteWizard installation
CD at \Accessories\XML\InstallXMLWin2000.exe.
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5 Using SiteWizard commissioning
software

5.1 Overview of using Hub Manager of Site Wizard

Summary

Use UltraSite BTS Hub Manager to configure and test the transmission units of
the BTS and its hub node during commissioning. You can commission the FXC
transmission units manually or based on a node file. When commissioning the
BTS or its hub node based on a node file, the UltraSite BTS Hub Commissioning
Wizard sends the node file to the node during commissioning. Commissioning
based on a node file allows some network setup tasks to be completed offsite.

Note

If the BTS configuration includes an FC E1/T1 transmission unit, that unit is
configured with the Commissioning Wizard in BTS Manager.

Steps

1. If manually commissioning the FXC transmission units with UltraSite BTS
Hub Manager,

Then

See Manual Hub configuration.

2. If commissioning FXC transmission units with UltraSite BTS Hub
Manager based on a node file,

Then

See Commissioning based on an off-line node file.

DN05168119
Issue 3-0 en

# Nokia Corporation 31 (309)

Using SiteWizard commissioning software



5.2 Overview of using BTS Manager of Site Wizard

Summary

The BTS Manager is a tool for configuring, commissioning, and managing the
BTS and related transmission equipment.

After the BTS is installed and commissioned, the BTS Manager allows you to
monitor and control the BTS operation, either locally at the site or remotely from
the Network Management System (NMS/2000) or NetAct. BTS Manager lets you
perform the following BTS management tasks:

. View and manage the BTS configuration in graphical format or as logical
objects.

. Monitor real-time status and alarm information with continuous and
automatic updates during the BTS Manager session.

. Check, load, or activate the BTS software locally.

. Reset, block, or unblock BTS units to replace them for local tests.

. Read new TRX Abis allocations and send them to the BTS when adding
TRXs or altering Abis settings for existing TRXs.

The BTS Commissioning Wizard within the BTS Manager guides you through
the commissioning tasks. Commissioning Wizard includes an·Undo
Commissioning option that sets the BTS to non-commissioned mode. This is
necessary if the BTS must be re-commissioned (for example, when it has been
commissioned with incorrect parameters). Running the Commissioning Wizard is
the third step in the overall commissioning sequence.

Steps

1. Define the BTS configuration with the Nokia BTS HW Configurator.

Nokia BTS HW Configurator allows you to use an existing configuration
or to create a new configuration, if there is not a pre-defined hardware
configuration file available for the BTS. A BTS HW configuration file
with basic BTS configurations is delivered with the Nokia BTS HW
Configurator. Use the default parameters or modify them as necessary.

2. Commission the FXC transmission units with the Nokia UltraSite BTS
Hub Manager.
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Use the Nokia UltraSite BTS Hub Manager to configure and test the
transmission of the BTS and its Hub node during commissioning. You can
commission FXC transmission units manually or based on a node file.
When commissioning based on a node file, send the node file to the node
during the commissioning procedure with the BTS Hub Commissioning
Wizard. This action allows more network setup to be performed offsite.

Note

If the BTS configuration includes an FC E1/T1 transmission unit, that unit is
configured with the Commissioning Wizard in the BTS Manager.

3. Commission the BTS with the BTS Commissioning Wizard (includes
FC transmission unit configuration).

Figure 7. Manual Commissioning option
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5.3 Using Site Wizard in Mini Outdoor commissioning

Before you start

BTS Manager and Hardware Configurator 4.1 CD2.2 are required for
commissioning and maintaining the UltraSite EDGE BTS Mini Outdoor.

Note

Administrator privileges are required to perform these actions.

Install BTS Manager, Hardware Configurator and General Communication
Services as instructed in Site Wizard installation instructions. To install BTS
Manager 4.1 CD2.2 for Mini Outdoor, follow the steps below.

Steps

1. Download BTS Manager and Hardware Configurator 4.1 CD2.2 from
www.online.nokia.com and save these files to a temporary directory on
the PC.

2. Create a directory called C:\Program files\Nokia\Mini UltraSite

3. Change the data under NOKIAMGR registry value to the target path:
C:\Program Files\Nokia\Mini UltraSite.

4. From the Windows Start menu select Run and enterregedit followed
by OK.

5. Browse to: HKEY_LOCAL_MACHINE\SOFTWARE\Nokia\GCS
Communication Service

6. Change the value of the data field to C:\Program Files\Nokia\Mini
UltraSite e.g. Registry key: HKEY_LOCAL_MACHINE
\SOFTWARE\Nokia\GCS Communication Service Registry Value:
NOKIAMGR Data: C:\Program Files\Nokia\Mini UltraSite.

7. Edit the Environment Variable for NOKIAMGR.
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Tip

Right Click on the “My Computer” icon on the desktop. Select the
“Properties” tab and “Advanced” tab followed by “Environment Variables”.
Select NOKIAMGR from the System Variables and edit this to read “C:
\Program Files\Nokia\Mini UltraSite”.

8. Install the Mini UltraSite BTS Manager 4.1 CD2.2 software to C:
\Program Files\Nokia\Mini UltraSite\BTSMan by running the setup.
exe program within the temporary directory created earlier.

9. Install the Mini UltraSite BTS Hardware Configurator 4.1 CD2.2
software to C:\Program Files\Nokia\Mini UltraSite\HWConfig by
running the setup.exe program within the temporary directory created
earlier.

10. Desktop shortcut icons can be added as required for the above
applications.

Further information

Restrictions of use:

. Only Microsoft Windows 2000 Professional and Microsoft Windows XP
Professional editions are supported.

. Simultaneous use of both of the BTS Manager / Hardware Configurator
versions is not supported.

. Launching of Transmission Element Managers from within BTS manager
is not supported. Element managers should be launched using the
appropriate shortcut or start menu item.

. Different versions of BTS Manager and Hardware Configurator cannot be
used remotely when installed on the same NetAct Node Manager Server
Platform. Due to this duplicate NetAct Node Manager Servers are required
for Mini UltraSite if remote management is required.

Different versions of BTS Manager and Hardware Configurator cannot be used
remotely when installed on the same NetAct Node Manager Server Platform. For
this reason, duplicate NetAct Node Manager Servers are required for Mini
UltraSite if remote management is required. See NetAct documentation for
installation and administration of the NetAct Node Manager Server.
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6 Overview of commissioning GSM/EDGE
UltraSite EDGE BTS

Before you start

Note

It is necessary to connect a frequency counter to the BOIx unit's 13 MHz test
port and power on the frequency counter before beginning the commissioning
procedure. This action enables the counter timer to warm up and provide
accurate measurements.

Summary

The BTS is manually commissioned using these Nokia software applications:

. BTS HW Configurator - a tool for creating, checking, and updating the
configuration of a BTS cabinet.

. BTS Hub Manager - a tool for configuring and testing the transmission of
the BTS and its Hub node (if there are FXC units in the configuration).

. BTS Manager - a tool for configuring, commissioning, and managing the
BTS and related transmission equipment. The BTS Commissioning Wizard
is included in the BTS Manager (includes FC E1/T1 transmission unit
configuration).
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Figure 8. Commissioning procedure overview

Note

Only one application can communicate with the BTS at a time. Close the BTS
HW Configurator before starting UltraSite BTS Hub Manager, and close Hub
Manager before starting BTS Manager.

Nokia BTS Manager and related UltraSite BTS Hub Manager software have a
convenient, context-sensitive online Help facility.

To get help, perform one of the following actions:

FC E1/T1 unit is used FXC E1/T1 unit is used

HW configuration
(Configuration Wizard in BTS HW Configurator)

FXC transmission configuration

(UltraSite BTS Hub manager)
line interface settings

radio configuration (for FXC RRI)
synchronisation
Q1 management
abis allocation

cross-connection

BTS commissioning

(Commissioning Wizard in BTS Manager)
BTS commissioning test (Abis loop test, TRX test)

EAC inputs/outputs

FC transmission configuration

(Commission Wizard in BTS Manager)
line interface settings

synchronisation
traffic manager

BTS commissioning

(Commissioning Wizard in BTS Manager)
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. Press F1

. Click the Help button on the toolbar

. Choose one of the Help menu commands

. Click the Help button in any dialog box

To exit Help, press ESC or ALT+F4.

The Help Topics window displays a set of tabbed pages:

. Contents - displays a list of topics organized in books by category.

. Index - lists keywords in alphabetical order through which different topics
can be reached.

. Find - provides a full-text search functionality that allows you to search for
any word or phrase in the Help file.

Note

All images in this document are typical in nature and are for general reference
only. For hardware, the versions depicted may differ from the latest version of
equipment. For software, any version numbers shown in any of the windows/
screens/dialog boxes may not be the same as the actual software that is to be
installed. It is important to remember that the procedure must be followed, as
these provide advice on the correct software to be installed and the correct text
to be displayed in each window/screen/dialog box.

Steps

1. Define the BTS configuration with Nokia BTS HW Configurator.

The Nokia BTS HW Configurator allows you to use an existing
configuration or to create a new configuration, if there is not a pre-defined
hardware configuration file available for the BTS. A BTS HW
configuration file with basic BTS configurations is delivered with the
Nokia BTS HW Configurator. Use the default parameters or modify them
as necessary.

2. Commission the FXC transmission units with Nokia UltraSite BTS
Hub Manager.
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Use the Nokia UltraSite BTS Hub Manager to configure and test the
transmission of the BTS and its Hub node during commissioning. You can
commission FXC transmission units manually or based on a node file.
When commissioning based on a node file, send the node file to the node
during the commissioning procedure with the BTS Hub Commissioning
Wizard. This action allows more network setup to be performed offsite.

Note

If the BTS configuration includes an FC E1/T1 transmission unit, that unit is
configured with the Commissioning Wizard in the BTS Manager.

3. Commission the BTS with the BTS Commissioning Wizard.

The BTS Commissioning Wizard guides you through the commissioning
tasks, including manual entry of the commissioning parameters.
Commissioning Wizard runs automatic BSC-controlled tests and generates
the BTS Commissioning Report, which contains information collected
during the commissioning procedure. FC E1/T1 transmission units are
configured during this step.
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Figure 9. Manual Commissioning option

Note

If the BTS is already commissioned, Undo Commissioning is the only option
available in the BTS Commissioning Wizard. Because the BTS can only be
commissioned in its non-commissioned state, this procedure is typically
necessary when the BTS must be re-commissioned (for example, when it has
been commissioned with incorrect parameters). The Undo Commissioning
procedure clears previous commissioning data from the BTS.
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7 List of instructions for BTS configuration
using MMI software

This section lists the instructions for configuring UltraSite and MetroSite Base
Transceiver Stations (BTS) with Nokia BTS Manager and Nokia BTS HW
Configurator software.

The instructions are available in the Online Helps of the applications. The Help
files can be accessed by clicking the application's Help menu.

Nokia BTS Manager Online Help (for UltraSite BTS and MetroSite BTS)

The following instructions provide help on the commissioning procedure and the
use of BTS Commissioning Wizard:

. Commissioning BTS

. Manual commissioning (for UltraSite and MetroSite respectively)

. Undo commissioning

The following instructions provide help on BTS object control:

. Changing TRX and BCF States

. Enabling/Disabling Abis

. Setting and Viewing EAC States (for UltraSite and MetroSite respectively)

. Setting and Viewing IDD Information

. Updating Abis allocations

. Viewing BTS Object Information

. Viewing the Site Configuration (for UltraSite and MetroSite respectively)

The following instructions can be used for testing the BTS after commissioning:
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. Testing the BTS

. Sending BCCH carrier

. Testing TRXs

. Testing TRX Loops

. Tracing TRX Traffic

For more information, see the appropriate BTS Product Documentation Set.

Nokia BTS HW Configurator Online Help (for UltraSite BTS only)

The following instructions provide help for managing configurations:

. Opening a configuration

. Creating and changing a configuration

. Saving a configuration to a file

. Printing configuration information

. Fetching/sending a configuration

. Fetching/sending configuration for upgrade units
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8 Using Commissioning Wizard to
commission the transmission node

8.1 Commissioning the transmission node with the
Commissioning Wizard

Before you start

To be able to commission the node with the Commissioning Wizard, both the
hardware and software must be installed and the node powered up.

Summary
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Figure 10. Commissioning process

Testing phase

Configuration phase

COMMISSIONING PROCESS

User Manager SW

Start MetroHub Manager

Run MetroHub tests:
- cross-connections
- fan
- heating
- external alarm
- battery

Check the test report and
give the battery serial
number if applicable

Select and accept the node
site configuration file or offline file
to send node settings to the node

Check radio hops

Check commissioning report
and store it into a file

Commissioning report created

Node settings are performed
- FXC unit settings
- OU settings

Connect to the node

Start Commissioning Wizard

Create site configuration file
or node offline file

All units are installed logically and
the manager reads the equipment
configuration from the node.

Node sets default settings
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Steps

1. Start the node manager.

2. Establish a connection to the node.

3. Select Configuration → Commissioning Wizard from the menu bar.

Note

Nokia delivers all units with factory settings. The node must not contain any
prior settings (such as cross-connections) when the manager is running the
Commissioning Wizard.

If the node manager detects modified settings, for example cross-
connections, the manager shows a note informing that it resets the factory
defaults before starting the Commissioning Wizard.

Figure 11. Commissioning note

The user can exit the Commissioning Wizard by clicking Cancel or
continue with the testing process by clicking Restore.
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If there are no prior settings or after the node has restored the factory
defaults, the manager installs all units logically and reads the equipment
configuration from the node while displaying a progress dialogue box.
After that, theWelcome dialogue box appears showing the tests that can be
run.

Figure 12. Welcome dialogue box

4. Test the node.

5. Configure the node.

6. Check the commissioning report.

Further information

The commissioning report is displayed in the End dialogue box. A
commissioning report contains the test results and information about how
the node is configured (node settings, the settings of each unit, cross-
connections).

7. If you want to give the file a name and a place on the disk to store the file
to

Then

Click To file...
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Give the file a name and browse to a suitable place on the disk and accept
it.

8. Click Finish to end the commissioning process.

The node manager refreshes the information.

Expected outcome

The commissioning report is protected and stored in a file. This file can be used,
for example, for site acceptance. Note that the file is a text file with the extension
.cmr and has to be opened with a text editor.

8.2 Testing with the Commissioning Wizard

Purpose

The testing phase contains activities which ensure that the hardware is
functioning properly. In this phase all feasible tests are run in the transmission
node and also in the transmission units found in the node.

The tests run at this phase are cross-connections test, fan test, heating test, battery
test, and EAC interface tests.

Note

USBTS Hub Manager allows only cross-connection tests.

Before you start

You have opened the Commissioning Wizard as described in Commissioning the
transmission node with the Commissioning Wizard.

Steps

1. Select the tests to be run.

All tests are run as default. Although you can select which tests to run, site
acceptance requires that all tests are completed successfully.

2. Start the testing process by clicking Next.
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The manager program executes the selected tests, and the results are shown
in the Testing dialogue box.

Figure 13. Testing dialogue box

Note

Running the tests takes about four minutes.

3. Check the results of the tests from the Testing dialogue box and fill in
the required fields.

4. Click Next.

The Site Selection dialogue box opens.

5. Continue the commissioning process as described in Configuring with
the Commissioning Wizard.
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8.3 Configuring with the Commissioning Wizard

Purpose

The configuration phase contains activities needed to make the node function in
the network. These activities include setting the node ID, Q1 and synchronisation
settings for the node, unit-specific settings for the transmission units, radio
parameters and cross-connections.

Before you start

After the testing phase, the Commissioning Wizard continues with the site
configuration.

The Site Selection dialogue box is open.

Figure 14. Site Selection dialogue box
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Steps

1. Click Browse.

The Commissioning Wizard opens a standard Windows dialogue box
where you can look for the corresponding file. The default search criteria is
.xml.

2. Browse to file that corresponds to the configuration and select it.

Only if you selected a valid XML file, a dialogue box opens where you can
select the correct site.

Figure 15. Site selection list dialogue box

If you selected a file other than XML, the manager returns to the Site
Selection dialogue box where the selected file is displayed.
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Figure 16. Site Selection dialogue box

3. If you selected an XML file

Then

Select the site and click OK.

The manager returns to the Site Selection dialogue box where the selected
file is displayed.

4. Click Next.

Click Next.

Some of the selected file data is shown to the user in the Accept Site
Selection dialogue box.
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Figure 17. Accept Site Selection dialogue box

5. Click Next to accept the selected node offline file and the site, and to
send node settings to the node.

The manager performs the node configuration check, that is, compares the
file equipment configuration against the node configuration. If there are
differences, the manager notifies about them with the note: Fix the
configuration and restart the commissioning process.

After the configuration is correct, all the settings are sent to the node and
units. The manager takes care of the node level settings and the integrated
FXC unit managers take care of the FXC unit related settings and possible
OU settings.
. If no radio units are used, the End dialogue box opens.
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Figure 18. End dialogue box

6. If FlexiHopper Plus radios are present

Then

In the Licence Manager page that is displayed, select the folder from
which the licence is installed to the FlexiHopperPlus supporting E-
licensing and click Next.
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Figure 19. Licence Manager in Commissioning Wizard

. If there are radios included in the configuration, the Check Hops
dialogue box opens.
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Figure 20. Check Hops dialogue box

You can monitor possible radio hops and fine-tune them. The
manager polls and updates the status of the radio outdoor units to the
dialogue box. For more detailed instructions, see the relevant radio
documentation.

If the configuration includes Nokia FlexiHopper radios, also fading
margin measurement is enabled.
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Note

After the first end of the hop is commissioned, the hop status is shown as Not
ready or Trying, no far-end found in the Check Hops dialogue box and in the
commissioning report.

A complete commissioning report, which contains the correct status of the
hop, can be obtained after the far-end of the hop has been commissioned.

After commissioning a new site or doing maintenance work at a site,
quite often an incoming signal level incorrect alarm (caused by the
outdoor units) is active until the result of the next 15 minute RX
level minimum measurement is above the configurable threshold.
Depending on the time point when the 15-minute measurement
interval starts, this could take between 15 and 30 minutes. To avoid
waiting and, thus, reduce operator OPEX costs, you can reset the
alarm by clicking the Reset RX level alarm button. The alarm will
only disappear if the incoming signal level is above the configured
minimum threshold (this is checked by the outdoor unit).

Click Next when the required hop statuses are acceptable to end the
polling.

Expected outcome

The End dialogue box opens and you can continue the commissioning process as
described in Commissioning the transmission node with the Commissioning
Wizard.

Further information

Note

Nokia recommend the use of *.nod files for commissioning.
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9 Hub configuration

9.1 Manual Hub configuration

Summary

Steps

1. Open the Nokia UltraSite BTS Manager.

From the Nokia Applications submenu in the Start | Programs menu in
Windows, select Nokia UltraSite BTS Manager.

Wait until the BTS Manager has properly started before moving to the next
step.

2. Start the Nokia UltraSite BTS Hub Manager.

Start Nokia UltraSite BTS Hub Manager from the BTS Manager's Tools
menu.

When the connection has been established, the Equipment view window
opens automatically.
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Figure 21. Equipment view in Nokia UltraSite BTS Hub Manager

3. If the connection fails,

Then

Troubleshoot the connection.

Verify the connection speed and LMP cable connection from the Tools |
Options | Manager options. You can also try the Connection | Connect...
command and enter the connection parameters in the Connect to Node
window. Using the Nokia Connection Tool, refer to the application's online
Help.

4. Define the LIF settings.

a. Define the FXC E1/T1 LIF settings.

b. Define the FXC RR1 LIF settings.

5. Adjust the identification settings.

6. Adjust the service interface settings.
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7. Configure the radio units for FXC RRI units.

8. Adjust the synchronisation settings.

9. Adjust the synchronisation loop bit settings.

10. Adjust the Q1 management settings.

11. Adjust the alarm property settings.

12. Allocate the transmission capacity.

13. Create the bi-directional cross-connections.

14. Exit UltraSite BTS Hub Manager.

BTS Manager opens automatically if you started the UltraSite BTS Hub
Manager from the BTS Manager.

9.2 Overview of upgrading the transmission node
manager and transmission unit software

Before you start

ITN releases from C2.0 support remote software download.

Note

Upgrade from C1.2 on site via the LMP connection.

Do any necessary hardware or BTS upgrades before the software upgrade.

Note

Remote user access level can be restricted. If user access levels are enabled,
only those remote users who have administrator rights gain full read/write
access to element manager.
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Steps

1. Upgrade the node manager from Nokia SiteWizard to your PC or
laptop as described in Installing transmission node software from
Nokia SiteWizard.

2. Upload the node settings for a back-up.

3. If upgrading new transmission unit software in MetroSite BTS

Then

Open the transmission unit manager.

4. Download the FXC transmission unit software.

If there are several FXC units using the same kind of software package in
the same cabinet, download the FXC unit software to the first unit (see
Downloading FXC transmission unit software for instructions). Then copy
the software from the first unit to the other(s), as described in Copying
transmission unit software between transmission units.

Note

When upgrading, activate the downloaded SW on the master FXC unit (the
unit in slot 1) before copying and activating the new SW on the other FXC
units.

5. Upgrade the radio outdoor unit software last, if it is required.

9.3 Installing transmission node manager software
from Nokia SiteWizard

Purpose

Use Nokia SiteWizard to install Nokia node managers, communication
components, and tools required to manage related Nokia equipment. Each
SiteWizard CD-ROM contains a compatible set of managers.

Before you start

To avoid compatibility problems, note the following:
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. Check the compatible versions of managers.

. If your PC already contains previous node manager installations, it is
recommended that you uninstall them before installing the new versions
from the SiteWizard CD-ROM.

. The user ID used in the installation process must have local administrator
rights when the software is being installed.

Note

Remote user access level can be restricted. If user access levels are enabled,
only those remote users who have administrator rights gain full read/write
access to element manager. For instructions, see Enabling user access level
control.

Steps

1. Start Windows.

2. Insert the Nokia SiteWizard installation CD-ROM into the CD-ROM
drive.

Insert the Nokia SiteWizard installation CD-ROM into your PC's CD-
ROM drive. The setup program should start automatically within a few
seconds.

3. If the setup program does not start automatically

Then

Double-click the CD-ROM drive icon in the My Computer window to
open the CD-ROM disk and then double-click the setup.exe program
icon in the window.

4. Follow the instructions displayed in the setup program.

Note

GCS should be chosen for installation along with the Node Managers.
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Expected outcome

The setup program copies the selected files. The user is notified when the
installation is complete.

9.4 Checking the transmission unit product codes and
versions with the manager

Purpose

The FXC unit product code and version number is printed on the label on top of
the unit. This label identifies the hardware and the software version of the unit at
the time of shipping from Nokia.

The FXC unit product code and the separate product code for software can be
checked locally or by the Network Management System (NMS) or NetAct.

Before you start

Note

For ITN C1.2 hardware, the boot code, boot code version, and hardware
version are not displayed.

Note

In the event of a software update to FXC E1, FXC E1/T1, FXC RRI, or FXC
Bridge, the Product Version and Product Version for HW will be set to N/
A.

Steps

1. Open the FXC unit's manager by clicking the unit.

2. If the unit is an FXC E1 unit

Then

Read the identifications in the E1 Manager under FXC E1/T1 →
Identifications.

3. If the unit is an FXC RRI unit
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Then

Read the identifications in the RRI Manager under FXC RRI →
Identifications → Unit/Outdoor Unit.

4. If the unit is an FXC STM-1 unit

Then

Read the identifications in the STM-1 Manager underFXC STM-1 →
Identifications.

5. If the unit is an FXC Bridge unit

Then

Read the identifications in the Bridge Manager underFXC Bridge →
Identifications.

Expected outcome

The manager displays the Identifications dialogue box.
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Figure 22. Identifications dialogue box

9.5 Downloading FXC transmission unit software

Purpose

You can download unit software into an FXC unit with the node manager both
locally and remotely. Remote download is supported in ITN C2.0 and later
releases.
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Transmission Loader, introduced in ITN C2.1, is an application for remote
software download. It enables automatic remote software upgrade to network
elements, using existing Q1 management channels. For more information, refer to
the Transmission Loader documentation available in NOLS under Maintenance.

Note

Readers should note that all images in this document are typical in nature and
are for general reference only. For hardware, the versions depicted may differ
from the latest version of equipment. For software, any version numbers
shown in any of the windows/screens/dialogue boxes may not be the same as
the actual software that is to be installed. It is important to remember that the
procedure steps must be followed, as these will give advice on the correct
software to be installed and the correct text that will be displayed in each
window/screen/dialogue box.

Before you start

Software can be downloaded to one unit at a time. If you have more units of the
same type in the cabinet, download software into one unit first and then use
software copy to update the rest of the units. Software copy is supported in ITN
C2.0 and later releases.

Note

When upgrading to ITN C2.2 release, the downloaded SWon the master FXC
unit has to be activated before the SW on other FXC units.

Summary

The FXC units have two software banks, and the active software bank always
contains the running software. Downloaded software is always stored into the
inactive software bank.

Downloading does not disturb the traffic in the transmission unit. However, after
the download is completed, you need to activate the software with the manager.
To activate the software, the unit executes a restart, which disturbs traffic in the
transmission network. In MetroSite EDGE BTS and UltraSite EDGE BTS, all
active calls may be cut.
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Note

Remote software download through the Q1 management channel may
decrease the performance of remote alarm and performance monitoring via
NetAct during software download.

The FXC application file extension is .pkt or .pkz (e.g. S36122D0.pkz). The file
name includes the software code of the application. The extension .pkt is used for
an uncompressed file and .pkz for compressed file. Therefore the .pkz file size is
smaller and download is faster with it. Compressed file is uncompressed in the
unit before stored into the flash. File compression is supported by ITN C2.0 and
later releases. Release SDH C1.0 does not support file compression (FXC Bridge
and FXC STM-1).

Software/hardware compatibility

The application file compatibility (SW/HW) is checked at the beginning of the
download by the unit software. If the file to be downloaded is not compatible, the
download is not executed further. In that case the manager displays an error
dialogue box when the download starts.

Figure 23. Download error message when SW/HW compatibility check fails

The inactive software bank is always cleared after a failed SW download.

Software/software compatibility
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All the FXC unit software in a cabinet must be from the same release, for
example ITN C2.1. The node master unit checks the release compatibility, and all
the slave units must have the same release software. If a units has active software
from a different release, the node gives the 221 Version mismatch alarm and
incompatible units are shown in the equipment view with a blue border. For
removing the blue border and cancelling the alarm, see 221 Version mismatch.

Note

The 221 Version mismatch alarm has to be cancelled in order to manage the
node successfully.

Note

The equipment view looks slightly different for UltraSite.

Figure 24. Version mismatch in the equipment view

Steps

1. Start the node manager.

2. Establish a connection to the node.
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3. In the Equipment view, click the FXC unit to be upgraded.

The FXC menu appears in the menu bar (on the left side of the Tools
menu).

4. If the FXC unit to be upgraded is an FXC RRI

Then

Select FXC RRI → Unit software → Unit.

The Unit Software Management dialogue box opens.

5. If the FXC unit to be upgraded is an FXC E1/T1

Then

Select FXC E1 → Unit software.

The Unit Software Management dialogue box opens.

Figure 25. Unit Software Management dialogue box

6. If the FXC unit to be upgraded is an FXC STM-1 unit

Then

Select FXC STM-1 → Unit software.
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The Unit Software Management dialogue box opens, and the FXC STM-
1(SDH) page is displayed.

7. If the FXC unit to be upgraded is an FXC Bridge unit

Then

Download both the SDH software component and PDH software
component for the FXC Bridge unit.

Download both the SDH and PDH software components for the FXC
Bridge unit as follows:

a. Select FXC STM-1 → Unit software.

b. Select the FXC Bridge (SDH) tab.

c. Follow steps 8 to 11 of this procedure, and step 13.

d. Select FXC Bridge → Unit software.

e. Follow steps 8 to 11 of this procedure, and step 13.

8. Click Download.

A standard Windows file selection dialogue box opens.

9. Select the file to be downloaded and click Open.

The download starts, and the Downloading Data dialogue box is
displayed.

Figure 26. Downloading Data dialogue box

The dialogue box displays information about the reliability of the
management channel used. The following counters are available:

DN05168119
Issue 3-0 en

# Nokia Corporation 71 (309)

Hub configuration



. Packet counter (which shows how many packets have been
downloaded)

. SWDL interrupt counter

. CRC error counter

The estimated duration, and the actual elapsed time, are displayed.

The discontinuation of the download can be easily seen when the packet
counter stops. If, for example, the connection is lost, the SWDL interrupt
counter is increased by one. The CRC error counter displays the number of
erroneous packets.The values indicate the performance of the DCN
channel.

The Downloading Data dialogue box is displayed during the whole
downloading process. It is closed after the download has been completed
and the Unit Software Management dialogue box is activated.

Note

To cancel the download, click Cancel. Note that the dialogue box may take
between 75 to 110 seconds to respond.

10. In case the transmission unit is operating in a Nokia BTS, block the
BCF with Nokia BTS Manager or request BCF lock from the BSC.

11. Activate the downloaded software by clicking Activate.

The manager starts the software activation, and the unit executes a restart.

Note

When upgrading to the ITN C2.2 release, activate the downloaded SW on the
master FXC unit before the other FXC units.

Activating new software disturbs traffic in the transmission network. In
MetroSite EDGE BTS and UltraSite EDGE BTS, all active calls may be cut.

When the activation is complete, the manager displays the downloaded
software in the active bank. The previously active software is now inactive.
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Figure 27. Unit Software Management dialogue box after software download

12. In case the transmission unit is operating in a Nokia BTS, unblock the
BCF with Nokia BTS Manager or request BCF unlock from the BSC.

13. Click Close.

9.6 Copying transmission unit software between
transmission units

Summary

Inside a node, software can be copied between similar types of FXC units:

. from any bank of an FXC E1(/T1) to the inactive bank of an FXC E1(/T1)

. from any bank of an FXC RRI to the inactive bank of an FXC RRI

The compatibility of the software is checked before it is downloaded (or copied).
The file to be copied is compared to the one in the target. Only software with the
same software code are allowed to replace each other.
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Note

Different hardware versions may in some cases require different software.
Refer to the Nokia ITN Integrated Transmission Node Release C3,
Compatibility document, which is available in NOLS.

The master unit of the node has a copy queue where the copy commands are
situated. The master unit executes the commands in the background one by one.
The copy queue has a maximum of four copy commands. If the queue is full, the
queue must be cleared before any new commands can be accepted. A copy
command can also include a software activation command, if the target is not the
master unit.

Steps

1. Start the node manager.

2. Establish a connection to the node.

3. Select Maintenance → Software Copy...

The Software Copy dialogue box opens.

Figure 28. Software Copy dialogue box

The Software Copy dialogue box includes an individual software
activation check box for each target FXC unit, which allows software
activation after copying on only the selected units, instead of all units. The
source and progress indication are also displayed for each target FXC unit.
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The right-most column in the Software Copy dialogue box shows the
progress, in percent, when copying is ongoing.

4. Select the source unit and the bank.

5. Select the target unit from the target group by clicking the checkbox.

6. If you want the manager to activate the software after copying

Then

Check the Activate after copying check box.

When upgrading to ITN C2.2 release, activate the downloaded SW on the
master FXC unit before copying and activating the new SW on the other
FXC units.

7. If you want to copy software from another source unit into another target
unit

Then

Repeat the steps above as many times as needed.

8. Click the Copy button.

Expected outcome

Software copying starts, and the progress is displayed in the Software
Copy dialogue box.

Figure 29. Software Copy dialogue box when copying ongoing
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After all the copy commands are executed and the Progress is set to Done.

Unexpected outcome

If there are mistakes in the copy definitions, click Clear. Note that this
clears all the selections you have made.

9. Click Close to close the dialogue box.

When the dialogue box is reopened, the copy progress is updated.

9.7 Downloading transmission unit software to
outdoor units

Purpose

New software can be downloaded to outdoor units from Nokia UltraSite EDGE
BTS, Nokia MetroSite EDGE BTS or Nokia MetroHub via an FXC RRI unit.

Before you start

Note

Activating the new software disturbs the traffic in the transmission network. In
Nokia MetroSite EDGE BTS and Nokia UltraSite EDGE BTS, all active calls
may be cut.

Before downloading, ensure that you have the correct file for each radio type
available.

Steps

1. To upgrade new outdoor unit software in Nokia UltraSite EDGE BTS or
Nokia MetroHub

Steps

a. Click either the outdoor unit or the corresponding FXC RRI
unit.

The FXC RRI menu opens in the menu bar.
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b. Select FXC RRI→ Unit Software→ Outdoor Unit for the radio
you need to upgrade.

The Software Management dialogue box opens for the radio you
need to upgrade.

Figure 30. Software Management dialogue box

2. To upgrade new outdoor unit software in Nokia MetroSite

Steps

a. Select Transmission → Open.

Nokia RRI Manager opens.

b. Select Maintenance → Unit Software → Outdoor Unit for the
radio you need to upgrade.

The Software Management dialogue box opens for the radio you
need to upgrade.

3. Click Download to browse for a file.

4. Click Open to start the download.
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The RRI Manager checks that SW code of the downloaded SW is the same
as the running SW in the outdoor unit.

If the code is not the same, an error dialogue box is displayed, which
informs you that the selected binary is not compatible with the OU.

5. Click Activate to activate the new software in each of the radio units.

Note

Activating the new software will cause an outdoor unit reset and thus
interrupting running traffic through that outdoor unit. Management
communication to the outdoor unit and traffic will be interrupted until the
outdoor unit has been started up again Start-up of the outdoor unit may take 30
seconds to 1 minute. The actual start-up time after a reset depends on the
outdoor unit type.

6. Repeat the procedure for the other outdoor units.

9.8 Installing and uninstalling transmission units
logically with the manager

Purpose

A MetroHub or BTS is only aware of a certain transmission unit if this unit has
been installed beforehand with the manager.

Note

The manager indicates a SW mismatch in a unit in an unnistalled state by a
blue border and a hash fill for that unit.

Steps

1. To install a unit logically in the offline mode:

Steps

a. Open a node file (.dat or .nod) or an SCF file (.xml).
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b. Right-click an empty slot to access the pop-up menu in the
Equipment window.

c. Select Unit →Install FXC (RRI, E1, E1/T1, Bridge, or STM-1)
from the pop-up menu.

Expected outcome

The installed unit can now be used.

2. To install a unit logically in the connected mode:

Before you start

You can only install a unit that is physically present in the connected mode.

Steps

a. Insert a new unit into UltraSite EDGE BTS or MetroHub
Manager.

b. Connect to a node.

c. Right-click the desired unit (the unit is displayed with diagonal
stripes) to access the pop-up menu in the Equipment window.

d. Select Install Unit from the pop-up menu.

Or

Select Install All from the pop-up menu if you want to install all
units at the same time.

3. To uninstall a unit logically with the manager

Purpose

You can logically uninstall one or more selected transmission units.

Note

Some unit-related node settings (for example: EOC, synchronisation, cross-
connections) are erased when a unit is uninstalled.
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Steps

a. Connect to a node or open a node file.

b. Point to the unit(s) to be uninstalled and click the right mouse
button to access the Equipment window pop-up menu.

c. Select the Uninstall Unit pop-up menu command.

Expected outcome

The uninstalled unit(s) can no longer be used, and you can physically remove the
unit(s).

Further information

You can also insert a new unit when you have already established a connection to
the node. In that case, to make the unit appear in the Equipment window, you
need to select Refresh All from the Equipment window pop-up menu.

9.9 Adjusting FXC E1/T1 and FXC E1 interface settings

Summary

Configuring the Line Interface (LIF) settings for a FXC E1/T1 or FXC E1 unit is,
with one exception, common and as result this section describes the possible
settings and options for both unit types.

Steps

1. To open the LIF settings dialogue box, select FXC E1/T1 → LIF
Settings, or FXC E1 → LIF Settings.

The LIF settings dialogue box opens.
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Figure 31. The LIF settings dialogue box

2. Select the LIF1, LIF2, LIF3, or LIF4 tab.

3. Add a specific name for the LIF in the 'Interface Name' field.

4. Click the Interface In Use check box to mark the LIF for activation.

Check the 'Interface in Use' check box to mark the LIF for activation. If
this check box is not checked, the interface will be not operational; it will
supply an AIS signal, and all interface-related alarms will be suppressed.

5. If you are adjusting FXC E1/T1 interface settings

Then

Select the Interface Mode in the drop-down menu.

Select the Interface Mode in the drop-down menu. The alternatives are E1
120 Ohm and T1 100 Ohm.
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Note

An interface configured to the E1 mode operates as an ITU G.703/ITU G.704
Interface with 2048Kbit/s. An interface configured to the T1 mode operates as
an ANSI T1.102/ANSI T1.403 Interface with 1544Kbit/s.

Note

For the FXC E1 unit, E1 75 Ohm is displayed. This value is fixed and cannot
be changed.

6. If the interface mode is T1 100 Ohm

Then

Adjust the settings for Framing Format, Line Code, and T1 Interface
Type.

Figure 32. The LIF settings dialogue box, T1 Interface Mode
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Adjust the settings for Framing Format, Line Code, and T1 Interface
Type:
. Under Framing Format, select either Extended Super Frame

(ESF) or Super Frame (SF).
. Under Line Code, select B8ZS or AMI.
. Under T1 Interface Type, select and configure either Network

Interface or DX1 Interface:
. Select Network Interface to insert additional attenuation into

the transmitter of the line interface, for standard T1 interface
operation. Configure the line build (7.5, 15, 22.5,or 0.0 B).

. Select DX1 Interface if the T1 line interface of the FXC E1/
T1 unit is connected to a device whose interfaces operate as
DSX1 interfaces. Configure the line length up to that device.

7. If the interface mode is E1 120 Ohm or E1 75 Ohm

Then

Adjust the settings for TSO Fixed Bits and CRC.

Adjust the settings for TSO Fixed Bits and CRC:
. By checking the CRC in use check box, the transmitted and

expected E1 frame is configured to be of CRC-4 multi-frame
structure. If the check box is not checked, a E1 basic frame structure
will be send and expected to be received.

. With the TS0 fixed bit settings it is possible to set the TS0 Sa bits
either to one or zero or T (transparent), dependent on the policy or
need within the network. If it is set to T then it represents the status
of the loops set by the software (M: Master control bit, L: Loop
control bit, E: EOC).

8. Click OK or Apply to activate the interface settings.

9.10 Adjusting FXC RRI interface settings

Purpose

The flexbus signal of the FXC RRI unit can multiplex up to 16 E1 signals. Each
of these 16 E1 signals can be made operational, and the frame format can be
selected (just as for the E1 line interface settings of a FXC E1/T1 or FXC E1
unit).
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Steps

1. Select FXC RRI → Settings → Unit.

2. Select the Flexbus 1 Interface tab or the Flexbus 2 Interface tab
(depending on the interface to be configured).

The Flexbus (1/2) Interface tab is displayed.

Figure 33. The Flexbus (1/2) interface tab

3. Click the In Use check box to mark the interface for activation.

If this check box is not marked, the interface will be not operational; it will
supply an AIS signal, and all interface-related alarms will be suppressed.

4. Select the interface capacity (2 - 16 x 2M).

Select the interface capacity according to the capacity of the microwave
radio link to be connected to it.

5. If the FXC RRI unit is directly connected to an outdoor unit (radio)

Then

select the Power On option.
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Select the Power On option to switch on the power for the outdoor unit.

Note

Do not use the Power On setting when two FXC RRI units are connected with
a flexbus cable, or when an FXC RRI and FIU 19(E) are connected with a
flexbus cable. This could damage the units.

6. Click OK or Apply to activate the Flexbus interface settings.

7. Select the Platform Interface tab.

The Platform Interface tab is displayed.

Figure 34. The Platform Interface tab

8. Click theInterface In Use check box for each interface to be activated.

If its check box is not marked, an interface will not be operational once the
settings are activated. The interface will send AIS signals, and all interface-
related alarms will be suppressed.
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Note

Platform interfaces 13, 14, and 16 are disabled if D-bus D12 or D13 is
enabled.

If a Nokia MetroHub is chained to a Nokia BTS, the platform interface 15 is
always allocated to relay capacity to the BTS internal D-bus. The interface
cannot be enabled.

9. Alternatively, click the Select All check box so that all the interfaces
are activated.

10. Click the CRC In Use check box for each interface to use a CRC-4
multi-frame structure.

If itsCRC in use check box is not marked, an interface will use E1 basic
frame structure.

11. Alternatively, click the Select All check box so that CRC In Use is
activated for all the interfaces.

12. Click the D-Bus In Use check box for each D-bus to be activated.

13. Click OK or Apply to activate the platform interface settings.

9.11 Allocating F(X)C transmission capacity

Summary

You must now allocate BTS transmission capacity on the D-bus. Use the Traffic
Manager, which is a graphical tool that allows you to allocate BTS transmission
capacity, regardless of which Nokia transmission unit is used. You must define
the unit (for example, 1 E1/T1), the interface (with FXC units), and the incoming
timeslot allocation on the Abis according to the transmission plan.

The D-bus allocation menu also allows for manual optimisation of cross-
connections along a D-bus. This is a manual process of allocation, whereas the
Traffic Manager performs this operation automatically.

By performing manual D-bus allocations, information for all traffic signals inside
the D-bus (EDAP, OMUSIG, TCH, TRXSIG) can be received by the BTS.
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If you use the D-bus allocations alone, you must create the cross-connections
individually with the Cross-connection Wizard. This method of allocation is used
to optimise the traffic in the D-bus.

Define the capacity to be used by selecting its signal type (EDAP, TCHs,
TRXSIG, OMUSIG, or TRXSIG on TCHs) and by reserving required time slots
and bits.

Note

In the case of 1.5 MB links (T1), the Traffic Manager automatically reduces
the number of time slot rows in the table to 24.

Steps

1. Open Traffic Manager.

Select the Traffic Manager command on the Configuration menu in Nokia
UltraSite BTS Hub Manager. The Traffic Manager window displays.
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Figure 35. Traffic Manager for an E1 link

2. Select the line interface being used.

Select from Interface 1 to Interface 4 with FXC E1(/T1) and up to 16
Channels/FlexBus with RRI transmission units. The number of available
channels is decreased when FlexBus capacity is set to other than 16 x 2M.
An FC E1/T1 unit has only Interface 1 available, because it has only one
line interface. For FXC STM-1, the maximum interface of the node is 190
x 2M (with 2 FXC STM1 and 4 Flexbus interfaces).

3. Allocate the transmission capacity.
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a. Click TCHs.

b. Click in a cell in the Abis allocation for the BTS time slot table.

c. Repeat step b to allocate transmission capacity to all TRXs in the
BTS configuration.

4. Select the link speed (alternative 1).

a. Click TRXSIG.

b. Click the first bit in a timeslot in the Abis allocation table.

c. Select the TRX to be defined from the pop-up menu.

d. Select the link speed from the pop-up menu.

e. Repeat steps b through d for all TRXs in the BTS configuration.

f. Click OMUSIG.

g. Click a cell in the Abis allocation table.

h. Select the link speed from the pop-up menu.

Or

5. Select the link speed (alternative 2).

a. Click TRXSIG on TCHs.

b. Click the first bit in a timeslot you reserved for TCHs in step 3.

c. Select the link speed from the pop-up menu.

d. Repeat step c for all TRXs in the BTS configuration.

e. Click OMUSIG.

f. Click a cell in the Abis allocation table.

g. Select the link speed from the pop-up menu.

6. If you want to modify the allocation table at this point,

Then

You must first delete prior allocations.

a. Right-click on the cell to be modified.

b. Delete either one signal allocation, all signal allocations, or all
allocations for the selected port.

Note

Choosing Delete all while modifying the allocation table deletes all
transmission capacity allocation from the D-bus without a warning. If you
execute the command by mistake, click Cancel and start the allocating
procedure again.
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7. Verify the signal timing.

Verify that the signal timing (either Normal or Satellite) is correctly set.

8. Click OK to send the information to the BTS.

Note

When the link capacity restricts normal signal allocation, you can use the
TRXSIG on TCHS signal type.

9. If you wish to automatically allocate D-buses and create required cross-
connections,

Then

Select an EDAP signal.

a. Make the first EDAP signal selection from the signal selection
group.

b. After the EDAP signal selection, mark a new EDAP. The EDAPs
connect to buses D12 and D13. Use the first free place for the new
EDAP.

Note

Do not change the locations of the existing EDAPs on Abis. If there are no
free places in other D-buses, connect an EDAP to bus D11.

Note

If you use Traffic Manager, then the D-bus allocation is NOT required to be
performed separately since Traffic Manager automates D-bus allocation
during this process.
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9.12 Creating bi-directional cross-connections

Summary

Because there is no cross-connections file available, cross-connections for each
transmission unit are created with the BTS Hub Manager’s cross-connections
tool. This FXC transmission unit configuration work includes also cross-
connections on the D-bus.

Cross-connections define how signals are routed from an FXC transmission unit
to another transmission unit. Cross-connections are created into banks that are
either active or inactive. The cross-connections in the active banks are in use,
whereas you can use those in the inactive banks for creating or editing cross-
connections. This procedure describes how to manually create bi-directional
cross-connections.

For more detailed information about cross-connections, see the Nokia MetroHub
Transmission Node documentation set.

Steps

1. Start creating cross-connections.

Select the Cross-connections menu in the Configuration menu.

2. Open the active bank page.

3. Copy cross-connection bank.

Click Copy to copy the active bank into the inactive bank.

4. Open the Add Cross-connection Wizard.

Go to the Inactive Bank and click Add to open the Add Cross-connection
Wizard.
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Figure 36. Add Cross connection Wizard

Or

5. Alternatively, initiate a cross-connection from the graphical view.

The Add Cross-connection Wizard displays.

6. Define the cross-connection settings.

Define the following settings according to the cross-connection plan:
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. label (name) of the new cross-connection (maximum 80 characters)

. cross-connection type; in this case, the type is bi-directional

. granularity (with nx64k set also its coefficient n)

7. Select the termination point settings.

Click Next to display the Overview window, where you can edit the
termination point(s).

Figure 37. Edit Termination Point view

8. If the FXC card is of E1T1 type,

Then
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Select the interface as the first termination point.

9. If the FXC card is of RRI type,

Then

Select the Flexbus as the first termination point.

10. If the RXC card is of RRI type,

Then

Select the Channel and the Interface.

Note

In the timeslot table, the reserved timeslots and bits are grey, while the
selected ones are blue. (If you modify your Windows colour settings, these
timeslot colours will change accordingly.)

11. Define the start bit of the frame.

Click a cell in the table to define the start bit of the frame. Click Next.

12. Repeat steps 7 through 11 to select the second termination.

13. If the cross-connection is of Protected type,

Then

Set the condition.

Click Condition to set the condition.

14. If the cross-connection is of Masked type,

Then

Set the Mask bits.

15. If the cross-connection is of Unidirectional Fixed Data type,

Then

Set the Fixed Data bits.

16. Exit the Add Cross-connections Wizard.
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Click Finish in the Overview window. The Wizard closes and you can view
the cross-connection in the cross-connection list and the graphical view.

17. To create other types of cross-connections, if necessary, repeat steps 5
through 16.

18. Activate the bank.

Either click Activate or right-click the Inactive Bank window and select
Activate to activate the bank.

19. If you wish to change cross-connection settings, you will need to
modify a bank.

a. To modify settings in an inactive bank, double-click the connection
in the Cross-connection list view in the Add Cross-connection
Wizard window.

b. Alternatively, you can select the connection and select Modify in the
pop-up menu (which displays when you right-click the mouse), or
you can select the connection and click Modify.

c. If you have activated the bank, you need to copy the cross-
connection information to the inactive bank for modification
because you cannot modify active banks.

Note

The copy command is also available in the pop-up menu.

20. Close the Cross-connection view.
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10 Adjusting transmission node settings

10.1 Overview of adjusting transmission node settings

Summary

It is possible to adjust the following settings using the manager:

. identification settings

. service interface settings

. synchronisation settings

. synchronisation loop bit settings

. alarm property settings

. Q1 management settings

Note

Circuit management settings are for Nokia internal use only. Trunet is a 2-bit
control channel.

Steps

1. If you want to adjust identification settings

Then

See Adjusting identification settings

2. If you want to adjust service interface settings

Then
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See Adjusting service interface settings

3. If you want to adjust synchronisation settings

Then

See Adjusting sychronisation settings

4. If you want to adjust synchronisation loop bit settings

Then

See Adjusting sychronisation loop bit settings

5. If you want to adjust alarm property settings

Then

See Adjusting alarm property settings

6. If you want to adjust Q1 management settings

Then

See Adjusting Q1 management settings

10.2 Adjusting node identification settings

Purpose

You can adjust the identification settings for the managed node using the
Hardware Identifications dialogue box. The user can fill in the name, site name,
group name and site location, and these are valid for the whole node.

Summary

Identification-related settings are not mandatory but it is strongly recommended
to use them.

Note

If you change the master FXC unit of the node, User Notes, Node
Identifications, and Node installation information is lost. The identification
settings of remaining units do not disappear.
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Steps

1. Connect to the node or open a file.

2. Select Configuration → Identifications.

The Hardware Identifications dialogue box opens.

Figure 38. Hardware Identifications dialogue box (MetroHub)
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Figure 39. Hardware Identifications dialogue box (UltraSite BTS Hub)

3. Click the tabs to switch between the pages.

Click the tabs to switch between the pages. The tabbed FXC page allows
you to view the codes, versions and serial numbers of the FXC units in the
node.

Note

The Outdoor Units button opens an Outdoor Units dialogue box where
available outdoor units are listed with the same information as shown in the
FXC Identifications dialogue box.

The Outdoor Units button is disabled if no outdoor units are present.

The following pages are specific to Nokia MetroHub:
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. The tabbed Node Identifications page, which allows you to view
and modify the following ID information: Equipment Name, Site
Name, Group Name and Site Location.

. The tabbed Node Installation page, which allows you to view
installation information, including user notes from the node.

. The tabbed Power page, which allows you to view power
identification information.

. The tabbed DIU page, which allows you to view DIU identification
information.

. The tabbed Fan page, which allows you to view Fan identification
information.

4. Select the identifications data you want to adjust, fill in the required
information and click OK.

10.3 Adjusting transmission unit identification settings

Purpose

This chapter instructs you in configuring FXC transmission unit identification
settings.

Summary

Identification-related settings are not mandatory but it is strongly recommended
to use them. Through the 'Identifications' dialogue box for each transmission unit,
unit names and installation dates can be specified.

Steps

1. Connect to the node or open a file.

2. Click the unit to be configured in the equipment view.

3. Click FXC (UNIT NAME) → Identifications to open the window (the
following diagram shows the FXC STM-1 window).
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Figure 40. FXC STM-1 Identifications, Unit page

4. Click the tabs (Unit / Unit Installation) to switch between the pages.

5. On the Unit page, type a Name for the unit.

6. On the Unit Installation page, insert installation Date and Time
manually or click Now.

7. Type the name of the Person who installed the equipment in the field.

8. Type possible additional information in the User Notes field.
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The maximum length for the notes is 900 characters. The text field above
the User Notes field shows the number of characters entered (for example
15/900).

9. Click Apply to confirm settings.

10. Click OK to close the dialogue box.

10.4 Adjusting service interface settings

Summary

You can adjust the settings of the LMP and the Q1 port. The settings are baud
rate, Q1 address and Q1 group address. It is also possible to adjust time-outs
under this menu.

The time-out settings concern the temporary settings of the whole node. These
include, for example, interface loops and forced controls.

Steps

1. Connect to the node or open a file.

2. Select Configuration → Service Interface.

The Service Interface dialogue box opens.
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Figure 41. The Service Interface dialogue box

3. Select either Port Settings or Timeouts.

4. Adjust the settings.

The supported baud rates for LMP are 9600–115 200 bit/s.

Supported remote Q1 connection rates are 1200 - 115200 bit/s
(recommended baud rate: 9600).

When using a Q1 external management port and a FXC RRI unit as master
unit, the maximum baud rate is 19200.

The default baud rate is 2400 bit/s for Q1 and 9600 for LMP. The default
address is 1 for the ports.

The Default buttons in the Timeouts tab set the default values (600
seconds) stored in the node (range is 60 - 6000).

5. Click Apply to apply the settings.

6. Click OK to close the window.
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10.5 Adjusting FXC E1/T1 and FXC E1 interface settings

Summary

Configuring the Line Interface (LIF) settings for a FXC E1/T1 or FXC E1 unit is,
with one exception, common and as result this section describes the possible
settings and options for both unit types.

Steps

1. To open the LIF settings dialogue box, select FXC E1/T1 → LIF
Settings, or FXC E1 → LIF Settings.

The LIF settings dialogue box opens.

Figure 42. The LIF settings dialogue box

2. Select the LIF1, LIF2, LIF3, or LIF4 tab.

3. Add a specific name for the LIF in the 'Interface Name' field.
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4. Click the Interface In Use check box to mark the LIF for activation.

Check the 'Interface in Use' check box to mark the LIF for activation. If
this check box is not checked, the interface will be not operational; it will
supply an AIS signal, and all interface-related alarms will be suppressed.

5. If you are adjusting FXC E1/T1 interface settings

Then

Select the Interface Mode in the drop-down menu.

Select the Interface Mode in the drop-down menu. The alternatives are E1
120 Ohm and T1 100 Ohm.

Note

An interface configured to the E1 mode operates as an ITU G.703/ITU G.704
Interface with 2048Kbit/s. An interface configured to the T1 mode operates as
an ANSI T1.102/ANSI T1.403 Interface with 1544Kbit/s.

Note

For the FXC E1 unit, E1 75 Ohm is displayed. This value is fixed and cannot
be changed.

6. If the interface mode is T1 100 Ohm

Then

Adjust the settings for Framing Format, Line Code, and T1 Interface
Type.
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Figure 43. The LIF settings dialogue box, T1 Interface Mode

Adjust the settings for Framing Format, Line Code, and T1 Interface
Type:
. Under Framing Format, select either Extended Super Frame

(ESF) or Super Frame (SF).
. Under Line Code, select B8ZS or AMI.
. Under T1 Interface Type, select and configure either Network

Interface or DX1 Interface:
. Select Network Interface to insert additional attenuation into

the transmitter of the line interface, for standard T1 interface
operation. Configure the line build (7.5, 15, 22.5,or 0.0 B).

. Select DX1 Interface if the T1 line interface of the FXC E1/
T1 unit is connected to a device whose interfaces operate as
DSX1 interfaces. Configure the line length up to that device.

7. If the interface mode is E1 120 Ohm or E1 75 Ohm

Then

Adjust the settings for TSO Fixed Bits and CRC.
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Adjust the settings for TSO Fixed Bits and CRC:
. By checking the CRC in use check box, the transmitted and

expected E1 frame is configured to be of CRC-4 multi-frame
structure. If the check box is not checked, a E1 basic frame structure
will be send and expected to be received.

. With the TS0 fixed bit settings it is possible to set the TS0 Sa bits
either to one or zero or T (transparent), dependent on the policy or
need within the network. If it is set to T then it represents the status
of the loops set by the software (M: Master control bit, L: Loop
control bit, E: EOC).

8. Click OK or Apply to activate the interface settings.

10.6 Adjusting FXC RRI interface settings

Purpose

The flexbus signal of the FXC RRI unit can multiplex up to 16 E1 signals. Each
of these 16 E1 signals can be made operational, and the frame format can be
selected (just as for the E1 line interface settings of a FXC E1/T1 or FXC E1
unit).

Steps

1. Select FXC RRI → Settings → Unit.

2. Select the Flexbus 1 Interface tab or the Flexbus 2 Interface tab
(depending on the interface to be configured).

The Flexbus (1/2) Interface tab is displayed.
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Figure 44. The Flexbus (1/2) interface tab

3. Click the In Use check box to mark the interface for activation.

If this check box is not marked, the interface will be not operational; it will
supply an AIS signal, and all interface-related alarms will be suppressed.

4. Select the interface capacity (2 - 16 x 2M).

Select the interface capacity according to the capacity of the microwave
radio link to be connected to it.

5. If the FXC RRI unit is directly connected to an outdoor unit (radio)

Then

select the Power On option.

Select the Power On option to switch on the power for the outdoor unit.
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Note

Do not use the Power On setting when two FXC RRI units are connected with
a flexbus cable, or when an FXC RRI and FIU 19(E) are connected with a
flexbus cable. This could damage the units.

6. Click OK or Apply to activate the Flexbus interface settings.

7. Select the Platform Interface tab.

The Platform Interface tab is displayed.

Figure 45. The Platform Interface tab

8. Click theInterface In Use check box for each interface to be activated.

If its check box is not marked, an interface will not be operational once the
settings are activated. The interface will send AIS signals, and all interface-
related alarms will be suppressed.
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Note

Platform interfaces 13, 14, and 16 are disabled if D-bus D12 or D13 is
enabled.

If a Nokia MetroHub is chained to a Nokia BTS, the platform interface 15 is
always allocated to relay capacity to the BTS internal D-bus. The interface
cannot be enabled.

9. Alternatively, click the Select All check box so that all the interfaces
are activated.

10. Click the CRC In Use check box for each interface to use a CRC-4
multi-frame structure.

If itsCRC in use check box is not marked, an interface will use E1 basic
frame structure.

11. Alternatively, click the Select All check box so that CRC In Use is
activated for all the interfaces.

12. Click the D-Bus In Use check box for each D-bus to be activated.

13. Click OK or Apply to activate the platform interface settings.

10.7 Adjusting external alarm inputs and control
outputs

Purpose

In MetroHub, there are ten external alarm inputs that can be activated by
connecting the input to GND. If an external alarm input is set in use, an active
alarm can be seen in the node manager and remote management system. The
polarity that generates the alarm can also be set (open or closed circuit).

There are also four open collector control outputs for external devices that are
controlled by the node manager.

Steps

1. Connect to the node or open a file.

2. Select Configuration → Programmable alarms.

DN05168119
Issue 3-0 en

# Nokia Corporation 111 (309)

Adjusting transmission node settings



The Programmable Alarms dialogue box opens.

Figure 46. Programmable Alarms dialogue box

3. Select the Input or Output tab, depending on what you want to modify.

Note

To save the changes you have made, always click the Apply button before
switching between the Input and Output tabs.

4. Select the alarm input or control output you want to modify.

5. Click Modify.

The Modify Alarm dialogue box opens.
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Figure 47. Modify Alarm dialogue box

6. Click the Active radio button to put the alarm into use.

7. Select the desired polarity (open or closed).

8. If you want to edit the name of the alarm

Then

Change the name of the alarm in the Interface Name field.

Note

The changed input alarm name is not transferred to the generated alarm when
the alarm point is active.

9. Click OK.

10. If you want to modify more programmable alarms

Then

Repeat the procedure above as many times as needed.

11. Click OK after you have modified all the desired inputs and outputs.
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10.8 Adjusting alarm property settings

Purpose

The Alarm Properties dialogue box allows you to view and modify the alarm
properties of a node, FXC transmission unit, and outdoor unit.

Steps

1. Select Configuration→ Alarm Properties to view and/or modify node
alarm properties.

Or

Select FXC (UNIT NAME)→ Alarm Properties to view and/or modify
FXC transmission unit or outdoor unit alarm properties.

Expected outcome

The Alarm Properties dialogue box opens.

Figure 48. Alarm Properties dialogue box

Further information

The Severity column shows a coloured alarm bell and text explaining the
severity of the alarm. The severity can be Critical, Major, Minor, or
Warning.

The Interface Type (on FXC STM-1) column shows the interface the
alarm relates to.
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The Code column shows the fault code.

The Description column shows the name of the alarm.

The Temporary column (not on FXC STM-1) shows the temporary state
of the alarm. The possible temporary states are normal, inhibited and
forced ON. If the temporary state is inhibited or forced ON, the state is
cancelled by the node's control timeout.

The Permanent column (not on FXC STM-1) shows the permanent state
of the alarm, that is, the state that will remain even after a HW reset. The
possible permanent states are normal, inhibited and forced ON.

The Section column is present for the FXC STM-1 only. It shows the name
of the functional entity that was the source of the alarm.

Table 5. Sections and their descriptions

Section Description

FXC STM covers SDH node wide functions, such as synchronisation
or real-time clock

FXC STM-1 covers functions specific to FXC STM-1, such as unit faults

FXC STM-1 IF 1 covers STM OS/RS/MS functions for STM interface 1

FXC STM-1 IF 2 covers STM OS/RS/MS functions for STM interface 2

FXC STM-1 S4 1 covers functions related to the S4 structure of STM signal
1

FXC STM-1 S4 2 covers functions related to the S4 structure of STM signal
2

FXC Bridge SDH covers functions related to added/dropped S12 structures
and PDH channels

2. Click the Modify button (not possible for warnings).

Or

Click the right mouse button over an alarm row and select Modify (not
possible for warnings).

Expected outcome

The Modify Alarm Properties dialogue box for the node opens.
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Figure 49. Modify Alarm Properties dialogue box

You can adjust temporary state, permanent state, and severity of the alarm.

Note

For an FXC STM-1 transmission unit, you can only adjust the severity of an
alarm. When you click the Modify button, the Modify Alarm Severities
dialogue box appears.

Note

Alarm severity can be modified in the Modify Alarm Properties dialogue
box. The modified alarm severity is visible in the local manager alarm
window. The alarm is reported to the NMS and BSC with an alarm code.
Local alarm severity modification does not override global severity settings in
the NMS or BSC.

3. Adjust the settings as desired and click OK.

Further information

Alarm property default settings can only be restored by resetting the transmission
node or units.
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11 Adjusting FXC STM-1 interface settings

11.1 Overview of adjusting FXC STM-1 interface settings

Steps

1. Click FXC STM-1 → STM-1 Interfaces.

2. Select an interface (Interface 1 or Interface 2).

A window for the selected interface opens.
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Figure 50. FXC STM-1 Interface 1, OS page

3. Click the tabs (OS / RS / MS / VC-4 / VC-4/TUG) to switch between
the pages.

11.2 Adjusting the OS interface settings

Purpose

On the Optical Selection (OS) interface settings page for the FXC STM-1
transmission unit, you can:

. change the Control State of the laser. The default state is on, but the laser
can be forced on or off for test and security reasons.

. see the latest fetched control state in the Current States selection. This
information is read from the node when the dialogue box opens.
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. switch on the Automatic Laser Shutdown (ALS) feature, which shuts
down the laser transmitter if the incoming optical signal is missing (the
laser then sends a two-second test pulse every 100 seconds, and restarts
automatically if the incoming signal is received again).

. restart the laser manually in cases of laser shut-down.

Steps

1. Select the OS tab to access the OS settings page.

Figure 51. FXC STM-1 Interface 1, OS page

2. Activate ALS by clicking the Automatic Laser Shutdown check box.

It is recommended to activate ALS by clicking the Automatic Laser
Shutdown check box. ALS is only available when the Control State of
the laser is On.

Click Apply.
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3. If you need to restart the laser manually after ALS

Then

Select the time you want the laser turned on, 2 seconds or 90 seconds,
and click Restart.

If the laser is shut down because of ALS, you do not have to wait for the
next test pulse (that occurs after 100 seconds have passed); you can
manually start the test pulse, which will turn on the laser for two or 90
seconds.

Select the time you want the laser turned on.

2 Seconds is used to check that the fibre is functional, and 90 Seconds is
used for measurement purposes. Both the 2 and 90 second modes send a
test pulse. If there is an input signal during the test pulse, the laser stays on.
If there is not, the laser is switched off again.

After selecting the time, click Restart.

4. Select the Control State of the laser.

Select the Control State of the laser by clicking on the following check
boxes/buttons:
. On is the default setting.
. With Forced On, the laser stays on even if there is no input signal

(however, if the hardware fails, the laser is automatically shut
down).

. With Forced Off, the laser is forced off.

Note

You need a local management connection to switch the laser on after a Forced
Off state.

Note

Forced settings do not persist if the unit is reset by power cycle or explicit unit
reset. After a reset, the control state of the laser returns to On.
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. With Test Shutdown, the laser is switched off for test purposes; it is
switched on automatically (the old value is restored) after a control
timeout. The control timeout is displayed in the Service Interface
dialogue box.

If you changed the Control State of the laser, click Apply.

5. If required, click Refresh in the Current States frame to read the new
laser state.

Click Refresh in the Current States frame to read the new laser state after
changes:
. If the Tx State is Off, the laser is currently switched off.
. If the Tx State is On, the laser is currently switched on.
. ATx State of ALS Sending Pulses means that the laser is currently

switched off because of ALS, but is sending test pulses for starting
up the link again (when the fibre connection is intact).

11.3 Adjusting the RS interface settings

Before you start

The Regenerator Section (RS) interface settings page for the FXC STM-1
transmission unit has two frames:

. Performance Collection

. Trail Trace Identifier

ATrail Trace Identifier (TTI) is a string of 15 definable characters that is used to
make sure the trails are routed correctly. Two TTIs are defined for each
termination point: Transmitted is sent to the remote end of the trail, and
Expected is expected to be received from the remote end of the trail. Different
TTIs are used in different directions to detect possible loopbacks.

The received TTI status field displays the current received TTI. It can be used to
verify that the received TTI matches the expected TTI.

Use the Refresh button to update the Received TTI status (the Received TTI
status is not automatically updated).

The use of TTIs is recommended, but not obligatory.
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Steps

1. Select the RS tab to access the RS settings page.

Figure 52. FXC STM-1 Interface 1, RS page

2. Select 15 minute and/or 24 Hour performance collection for RS.

Select the required checkbox to enable 15 minute and/or 24 Hour
performance collection for RS. Both functions can be employed separately.

3. Click on the Mismatch Monitoring checkbox to turn switch Mismatch
Monitoring on or off.
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Note

The expected TTI is only monitored against the received TTI if mismatch
monitoring is switched on.

The expected TTI and the received TTI are compared only if the Mismatch
Monitoring check box is checked.

4. It is recommended that you fill in the Transmitted and Expected TTI
fields.

It is recommended that you fill in the Transmitted and Expected TTI
fields. All 15 characters must be used, for equipment compatibility reasons.
An empty space is a valid character. The lines under the fields indicate the
number of characters used.

Note

The values are not read from the node when the dialogue box opens, which
means that earlier configured values are visible.

If a mismatch occurs between the expected and the received TTI, the Trace
identifier mismatch alarm is displayed.

11.4 Adjusting MS interface settings

Purpose

On the Multiplex Section (MS) interface settings page for the FXC STM-1
transmission unit, you can enable 15 Minute and/or 24 Hour performance
collection for MS. Both functions can be employed separately.

Steps

1. Select the MS tab to access the MS settings page.
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Figure 53. FXC STM-1 Interface 1, MS page

2. Click on the 15 minute checkbox to enable 15 minute performance
collection for MS.

3. Click on the 24 Hour checkbox to enable 15 minute performance
collection for MS.

4. Click Apply.

11.5 Adjusting the VC-4 interface settings

Purpose

The Virtual Container 4 (VC-4) interface settings page for the FXC STM-1
transmission unit has two frames:

. Performance Collection

. Trail Trace Identifier
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ATrail Trace Identifier (TTI) is a string of 15 definable characters that is used to
make sure the trails are routed correctly. Two TTIs are defined for each
termination point: Transmitted is sent to the remote end of the trail, and
Expected is expected to be received from the remote end of the trail if monitoring
is on. Different TTIs are used in different directions to detect possible loopbacks.

Use the Refresh button to update the Received TTI status (the Received TTI
status is not automatically updated).

The use of TTIs is recommended, but not obligatory.

Steps

1. Select the VC-4 tab to access the VC-4 settings page.

Figure 54. FXC STM-1 Interface 1, VC-4 page

2. Select 15 minute and/or 24 Hour performance collection for VC-4.
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Select the required checkbox to enable 15 minute and/or 24 Hour
performance collection for VC-4. Both functions can be employed
separately.

3. Click on the Mismatch Monitoring checkbox to turn switch Mismatch
Monitoring on or off for VC-4.

4. It is recommended that you fill in the Transmitted and Expected TTI
fields.

It is recommended that you fill in the Transmitted and Expected TTI
fields for the VC-4 interface. All 15 characters must be used, for equipment
compatibility reasons. An empty space is a valid character. The lines under
the fields indicate the number of characters used.

Note

The values are not read from the node when the dialogue box opens, which
means that earlier configured values are visible.

If a mismatch occurs between the expected and the received TTI, the Trace
identifier mismatch alarm is displayed.

11.6 Adjusting VC-4/TUG interface settings

Purpose

The Virtual Container 4/Tributary Unit Group (VC-4/TUG) interface settings
page for the FXC STM-1 transmission unit contains one frame, VC-4 Path label.

VC-4 Path label carries information about the payload type and indicates how
the signal is constructed.

In this release, the only possible VC-4 Path Label is TUG Structure; you cannot
modify the settings.

Steps

1. Select the VC-4/TUG tab to access the VC-4/TUG settings page.
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Figure 55. FXC STM-1 Interface 1, VC-4/TUG page

2. If required, use the pop-up Refresh to refresh the data.
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12 Adjusting FXC STM SDH-PDH channel
settings

12.1 Overview of adjusting FXC STM-1 SDH-PDH
channels settings

Purpose

The FXC STM-1 unit supports adding/dropping 20 VC-12 (containing a 2M
signal each).

Steps

1. Click FXC STM-1 → SDH-PDH Channels to open the window.

Figure 56. FXC STM-1 SDH-PDH Channels, Trail Trace Identifier page
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2. Click on a tab (Trail Trace Identifier / Performance Collection / VC-12
Path Label / VC-12 Mapping Mode) to view and modify the respective
settings.

12.2 Adjusting TTI settings

Purpose

On the Trail Trace Identifier (TTI) page, you can view and modify trail trace
settings for the 20 SDH-PDH channels.

The Channel column shows the unique channel identification number, which
determines the order of the items in the list. The Monitoring column shows
whether mismatch monitoring is Monitoring or Off. The Transmitted column
shows the transmitted trace identifier. The Expected column shows the expected
trace identifier. The Received column shows the received trace identifier.

Use the Refresh button to update the Received TTI status (the Received TTI
status is not automatically updated).

You can modify the settings for one or several channels at a time.

Steps

1. Select FXC STM-1 → SDH-PDH channels.

2. Select the Trail Trace Identifier tab to access the TTI settings.

The Trace Trail Identifier settings are displayed.
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Figure 57. The Trace Trail Identifier settings

If a mismatch occurs between the expected and the received TTI, the Trace
identifier mismatch alarm is displayed.

3. Select the channel/channels you want to modify.

Select the channel/channels you want to modify. To select multiple
channels, hold down the Ctrl key or the SHIFT key on your pc keyboard
while clicking.

4. Click Modify to open the Trail Trace Identifier dialogue box.
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Figure 58. Modify Trail Trace Identifier dialogue box

5. Switch Mismatch Monitoring on/off by selecting/clearing the
checkbox.

6. Fill in the Transmitted and Expected TTIs, using all 15 characters.

Fill in the Transmitted and Expected TTIs. The lines under the fields
indicate the number of characters used.

Note

Fill in all 15 characters, for equipment compatibility reasons. Use empty
spaces, for example.

7. Click OK to apply the settings to all selected channels.

8. Click Apply to send the changes to the node.

12.3 Modifying Performance Collection settings

Purpose

In the Performance Collection page, you can view and modify performance
collection settings. The Channel column shows the unique channel identification
number, which determines the order of the items in the list. The 15 minute
column shows whether 15 minute performance collection is On or Off. The 24
hour column shows whether 24 hours performance collection is On or Off.
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You can modify the settings for one or several channels at a time.

Steps

1. Select FXC STM-1 → SDH-PDH channels.

2. Select the Performance Collection tab.

The Performance Collection settings are displayed.

Figure 59. The Performance Collection settings

3. Select the channel/channels you want to modify.

Select the channel/channels you want to modify. To select multiple
channels, hold down the Ctrl key or the SHIFT key on your pc keyboard
while clicking.

4. Click Modify to open the Performance Collection dialogue box.

5. By selecting/clearing the boxes, switch 15 minute and/or 24 hour
performance collection on/off.

6. Click OK to apply the settings to all selected channels.
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7. Click Apply to send the changes to the node.

Further information

You can check the monitoring results in the Statistics History dialogue box.

12.4 Viewing the VC-12 Path Label

Purpose

In the VC-12 Path Label page, you can view VC-12 path labels for the SDH-
PDH channels. The Channel column shows the unique channel identification
number, which determines the order of the items in the list. The Transmitted
column shows the path label transmitted. The Expected column shows the path
label expected. The expected path is the same as the transmitted one. The
Received column shows the path label received.

Note

You cannot modify the path labels in the current version of the software.

If a mismatch occurs between the expected and the received VC-12 Path Label,
either alarm Unequipped signal or Payload mismatch occurs.

Steps

1. Select FXC STM-1 → SDH-PDH channels.

2. Select the VC-12 Path Label tab.

The VC-12 Path Label settings are displayed.
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Figure 60. The VC-12 Path Label settings

3. Click on a channel to highlight it.

12.5 Viewing and adjusting the VC-12 Mapping Mode

Purpose

In the VC-12 Mapping Mode page, you can view and modify the mode of the
transmitted mapping for each of the 20 SDH-PDH channels. The Channel
column shows the unique channel identification number, which determines the
order of the items in the list. The Mapping Mode column shows the mapping
mode, which is Asynchronous or Byte Synchronous (2048 kbit/s).

The 31*64 kbit/s bytesynchronous mapping mode is not supported and cannot be
configured.

You can modify the settings for one or several channels at a time.

Steps

1. Select FXC STM-1 → SDH-PDH channels.

2. Select the VC-12 Mapping Mode tab to access the VC-12 Mapping
Mode settings.
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The VC-12 Mapping Mode settings are displayed.

Figure 61. The VC-12 Mapping Mode settings

3. Select the channel/channels you want to modify.

Select the channel/channels you want to modify. To select multiple
channels, hold down the Ctrl key or the SHIFT key on your pc keyboard
while clicking.

4. Click Modify to open the VC-12 Mapping Mode dialogue box.

5. Select eitherAsynchronous or Byte Synchronous.

6. Click OK to apply the settings to all selected channels.

7. Click Apply to send the changes to the node.
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12.6 Configuring 2M multiframe CRC4 settings for FXC
STM transmission units

Purpose

From the CRC4 Multi-Frame page, you can view and modify the CRC-4 Multi-
Frame settings for each SDH-PDH channel. The Channel column shows the
unique channel identification number, which determines the order of the items in
the list. The CRC4 Multi-Frame column shows the CRC4 Multi-Frame setting,
which is Auto (not supported by current release), In Use, or Not in Use. The
default setting is In Use.

You can modify the settings for one or several channels at a time.

Steps

1. Select FXC STM-1 → SDH-PDH channels.

2. Select the CRC4 Multi-Frametab.

The CRC4 multiframe settings are displayed.

Figure 62. The CRC4 Multi-Frame settings
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3. Select the channel/channels you want to modify.

Select the channel/channels you want to modify by clicking. To select
multiple channels, hold down the Ctrl key or the SHIFT key on your pc
keyboard while clicking.

4. Click Modify to open the CRC4 Multi-Frame dialogue box.

The CRC4 multiframe dialogue box opens.

Figure 63. The CRC4 Multi-Frame dialogue box

5. Select either In Use or Not in Use.

6. Click OK to apply the changes to all selected channels.

7. Click Apply to send the changes to the node.
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13 Adjusting management settings

13.1 Overview of adjusting management settings

Purpose

The following sections detail how to adjust the management settings of the
transmission node.

Steps

1. Adjust SDH management channel settings.

2. Adjust node synchronisation settings.

3. Manage cross-connections.

Further information

For information on the Q1 settings, see Technical description of Q1
management and Q1 management options for Nokia MetroHub.

13.2 Adjusting SDH management channel settings

Purpose

In the SDH Bus page, you can:
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. select DCCm-DCCm (D4-D12) to make a transparent connection between
both STM-1 interfaces via the DCCm channel, which any management
transmission data can pass through. DCCm is an STM-embedded
management channel in the multiplex section.

. add, modify and delete SOH-SOH Embedded Operating Channel (EOC)
settings. With these settings, you can establish transparent connections of
SOH bytes between both STM-1 interfaces. This allows the bypass of any
management data transmitted via an SOH byte.

There is no add/drop function for DCCm and for the SOH cross-connection.

Steps

1. Click Configuration→ Q1 Management to open the Q1 Management
channel dialogue box.

2. Select the SDH Bus tab to access the SDH management channel
settings.

The SDH management channel settings are displayed.

Figure 64. Q1 Management, SDH Bus page

3. If necessary, activate the DCCm channel connection.
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If necessary, click the DCCm-DCCm (D4-D12) check box to activate the
DCCm channel connection. Click Apply.

4. To add SOH-SOH channel connections

Steps

a. Click Add to open the Add SDH EOC dialogue box.

The Add SDH EOC dialogue box opens.

Figure 65. Add SDH EOC dialogue box

b. Assign the first connection point by select Interface 1 or 2 in the
SOH1 frame.

c. Click to select an accessible (light-grey) SOH byte in the SOH1
selection graph.

d. Repeat steps 4-b and 4-c for the second connection point, in the
SOH2 frame.
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e. Click the In Use check box at the top of the window.

With the In Use check box, you can activate or deactivate SOH-
SOH connections in the FXC STM unit, without deleting them from
the node manager.

f. Click OK.

g. Repeat steps 4-a to 4-f as required, to add further SOH-SOH
connections.

Note

Up to 16 SOH cross-connections can be configured.

h. Click Apply to create the SOH-SOH connections in the FXC
STM unit.

Click Apply to create the SOH-SOH connections in the FXC STM
unit. If In Use was selected for an SOH-SOH connection, it will be
activated.

5. To modify an SOH-SOH channel connection

Steps

a. Click on an existing SOH-SOH connection in the EOC setting
list.

b. Click Modify to open the Modify SDH EOC dialogue box.

The Modify SDH EOC dialogue box opens.
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Figure 66. The Modify SDH EOC dialogue box

c. Modify the settings, then click OK.

d. Click Apply to set the changes in the FXC STM unit.

6. To delete SOH-SOH channel connections

Steps

a. Click on a existing SOH-SOH connection in the EOC setting list.

b. Click Delete.

c. Click Apply to delete the connection, and to set the changes in
the FXC STM unit.
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13.3 Adjusting Q1 management settings

Purpose

You can adjust the Q1 management settings of a node. These settings enable
remote management when used.

Summary

To enable remote management, a transmission channel for Q1 has to be created.
With UltraSite BTS Hub, Q1 is embedded in the OMUSIG channel. With
MetroHub, a dedicated Q1 DCN channel has to be created.

To get MetroHub under Q1 management, you must further set up a Q1 hybrid.

Steps

1. Connect to the node or open the node file.

2. Select Configuration → Q1 Management.

The Q1 Management dialogue box opens. The Q1 routing switches (Q1
hybrid) are displayed in the graphical form.

The external and processor switches (see figure below) are closed by
default in Nokia MetroHub.

144 (309) # Nokia Corporation DN05168119
Issue 3-0 en

Commissioning UltraSite EDGE BTS



Figure 67. The Q1 management dialogue box

3. Select the PDH Bus tab.

The PDH Bus tab opens.
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Figure 68. The PDH Bus tab

4. Click Add.

The Add EOC dialogue box opens.
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Figure 69. The Add EOC dialogue box

5. Select the unit to be configured.

6. Select the interface to be configured.

In FXC E1 and FXC E1/T1, there are four interfaces to choose from.

In FXC RRI, there are two Flexbuses and up to 16 channels available per
Flexbus, depending on the Flexbus capacity setting. There are also two
possibilities for Q1 channel, the EOC in the payload and the EOC in the
radio overhead.

In FXC Bridge, there are 20 interfaces to choose from.

7. If you want to carry the Q1 management in the payload

Then

Select a timeslot and sampling rate on the selected interface or
channel.

If 64 kbit/s sampling rate is selected, the whole timeslot is reserved for Q1
and no bit selection is required. If a lower sampling rate is selected, the bits
inside the selected timeslot have to be selected. The sampling rate options
are 64, 32, 16 and 8 kbit/s in timeslots 1−31 and 16, 8 and 4 kbit/s in
timeslot 0. In case of timeslot 0, only the bits 5–8 are allowed for EOC
usage.
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Note

It is recommended that the sampling rate is at least four times higher than the
baud rate used in the Q1 port.

8. If you want to carry the Q1 management in the radio overhead

Then

Select a Flexbus and overhead on the selected FXC RRI unit.

Select either Overhead 1 or 2, depending on the selected Flexbus.
Overhead 1 corresponds to Flexbus 1 and Overhead 2 corresponds to
Flexbus 2. After this selection has been made, no further configurations for
sampling rate are required because the sampling rate is fixed so that it is
always at least 64 kbit/s.

The advantage of using the overhead channel for Q1 is that it does not
waste payload.

9. Click OK to add Q1 information to the list of EOCs.

10. Click Apply or OK to apply the PDH Bus settings to the node.

Further information

If the managed area is divided to different Q1 buses (see Q1 management) or the
Q1 channel is otherwise forwarded over the transmission node, the EOC channel
is just cross-connected as normal data towards other equipment.
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14 Adjusting transmission node
synchronisation settings

14.1 Overview of adjusting node synchronisation
settings

Purpose

Node Synchronisation settings can be viewed and modified through the
Configuration menu in the manager.

The following sections detail each possible step.

Steps

1. Adjust synchronisation loop bit settings.

2. Adjust PDH synchronisation settings.

3. Adjust SDH synchronisation settings.

14.2 Adjusting synchronisation loop bit settings

Steps

1. Connect to the node or open a file.

2. Select Configuration → Synchronization...

The Synchronization dialogue box opens.

3. Click the Loop Bits tab.

The Loop Bits tab opens.
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Figure 70. The Loop Bits tab in the Synchronization dialogue box

You can select between two topologies: Chain or Loop. It is recommended
to use the Chain setting when the hub is used in a chain or tail
configuration, and the Loop setting when the hub is a part of a loop
configuration.

When configuring synchronisation loop bit settings and selecting Loop, a
remote alarm indication in E1 (which is the active synchronation source) is
interpreted as a synchronisation fail and the synchronation source switches
to the protecting synchronation source. This way, undirectional faults are
detected and protected in a loop network.

4. Click Add.

5. Select a transmission unit.

6. Select the interface.

7. If you selected FXC E1 or FXC E1/T1 unit
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Then

Select interface for the loop bits.

8. If you selected FXC RRI unit

Then

Select Flexbus and channel for the loop bits.

9. Select the desired settings for MCB (master clock bit) in the master
group and LCB (loop control bit) in the loop group.

10. Click OK.

14.3 Adjusting PDH synchronisation settings

Purpose

On the Priorities page, you can view and modify synchronisation priorities. The
PDH Priorities section contains the following columns: Priority number,
Timing, Unit, FB/IF (Interface), Channel, and Platform interface.

You can also modify PDH settings. The Modify Priority dialogue box contains
entries for the following:

. Priority number. The timing entry with the highest priority is selected as
timing source. If it fails, the node uses the next active timing entry as
source, until the higher entry becomes active again.

. Timing shows the timing source:
. RX Clock. This should be selected if the timing source is a 2.048

Mbit/s E1 signal (or 1.544 Mbit/s with T1) at the FXC E1, FXC E1/
T1, or FXC RRI.

. Sync Input. The fourth interface of an E1 or T1 interface can be
configured as an external synchronisation input interface. A 2.048
kHz synchronisation input signal can be used to connect to this
interface and act as synchronisation source.

. Internal Timing. If Internal Timing is the source for a priority, all
subsequent priorities will be disabled.

. Unit, which shows the unit type and slot number of the FXC units
installed. If the timing source is RX Clock or Sync Input, Unit refers to
the unit where the interface of the timing source is located.

DN05168119
Issue 3-0 en

# Nokia Corporation 151 (309)

Adjusting transmission node synchronisation settings



. FB/Interface, which specifies the interface to be used as timing source.
This need only be configured for an RX Clock timing source: for FXC
RRI, anFB interface, and for FXC E1, FXC E1/T1, an E1 or T1 interface.

. Channel, which allows the E1 channel to be used within a Flexbus
interface. If an E1 within a Flexbus is used as timing source, the location of
the E1 with the Flexbus signal must be specified.

If an E1 within a Flexubs interface is configured as timing source, the related
platform interface is displayed as static text.

Steps

1. Click Configuration → Synchronization to open the Synchronization
dialogue box.

The Synchronization dialogue box opens.

Figure 71. The Synchronization dialogue box

2. Select the tab Priorities to switch to the synchronisation settings (see
the following figure).
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3. Select a priority by clicking on it.

4. Click Modify to access the Modify Priority dialogue box for that
priority.

The Modify Priority dialogue box opens.

Figure 72. The Modify Priority dialogue box

5. Select the timing source from the Timing pull-down menu.

Select the timing source from the Timing pull-down menu. The
alternatives are RX Clock, Sync Input, Internal Timing, or None.

Note

If Internal Timing is the source for a priority, all subsequent priorities will be
disabled. The Unit and Interface boxes for the selected internal timing source
will also be disabled.

The use of Internal Timing for a priority generates a minor 'frequency error'
alarm.
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Note

If all higher priority synchronisation sources have failed, the internal clock
will be selected as the synchronisation source - even if internal timing is not
the designated source. Instead of the minor 'frequency error' alarm, a critical
'loss of synchronisation signals' alarm will be raised.

Note

You can only select Sync Input for an FXC E1(/T1) unit, and the interface is
always 4. Remember also to change the Interface Mode setting in the FXC /
LIF Settings dialogue box to Sync Input.

6. Select the unit from the Unit pull-down menu.

Select the unit from the Unit pull-down menu. If you select Sync Input, the
unit can only be FXC E1(/T1). The Unit menu is disabled if the Timing is
Internal Timing.

7. Select the interface from the FB/Interface pull-down menu.

Select the interface from the FB/Interface pull-down menu. The selection
depends on the unit in question. The FB/Interface menu is disabled if the
Timing is Internal Timing or Sync Input.

8. Select the channel from the Channel pull-down menu.

Select the channel from the Channel pull-down menu. For FXC E1 or
FXC E1(/T1), the Channel menu is disabled.

9. Click OK.

10. Click Apply to apply the settings to the node.

11. Repeat steps 3 to 10 as necessary for other priorities.

12. If necessary, click Calibrate to calibrate the internal clock to the
current active synchronisation source.

If necessary, click Calibrate to calibrate the internal clock to the current
active synchronisation source.
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Note

Before calibrating, check that the accuracy of the timing source used for
calibration is within a range of +-40 ppm. The accuracy of the calibration is
within a range of +-10 ppm, which is well within the limits of +-50 ppm
required for a PDH clock. However, if the timing source used for caliberation
has a frequency higher than +40 ppm, the calibrated clock may be out of
range.

Note

This button is not available in offline mode or when the active synchronisation
source is Internal Timing.

14.4 Adjusting SDH synchronisation settings

Purpose

On the Priorities page, you can view and modify SDH synchronisation priorities
if an FXC Bridge and FXC STM unit are installed.

By default, three synchronisation sources can be selected and prioritised: STM
interface 1 (STM-1 IF:1), STM interface 2 (STM-1 IF:2), and Internal. If the FXC
Bridge unit is installed in slot 1 (the slot for the node master), and a FXC E1 or
FXC E1/T1 unit is installed, it is also possible to specify an E1 signal from the
first E1 interface of an FXC E1 or FXC E1/T1 as the synchronisation source.

The SDH priority settings are presented in the following columns:

. Priority number. In Use Priorities mode, priority is of secondary
importance: if two synchronisation sources have the same quality, priority
decides which synchronisation source will be selected.

. Source, which can be modified (with the exception of Internal).

. Quality. In Use Priorities mode, quality is the of primary importance:
unless two synchronisation sources have have the same quality, quality
decides which synchronisation source will be selected.
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. Determination, which can be SSM (Synchronisation Status Message) or
Manual. With SSM , the quality of the synchronisation source is indicated
by a signal that can be used as the synchronisation source. With Manual,
the quality of the synchronisation source is configured manually. For an E1
signal, only Manual determination is available.

. Status.

You can also modify the SDH Synchronisation Mode: the alternatives are Use
Priorities, Force On, and Hold Over.

Before you start

The Synchronize PDH to SDH check box allows the PDH network to be
synchronised to SDH.

If the FXC Bridge is installed in slot 1, the Synchronize PDH to SDH check box
is checked and disabled in the view.

If the FXC bridge is installed in a slot other than 1, and a PDH unit is installed in
slot 1, then the Synchronize PDH to SDH check box is empty, and enabled in
the view. The PDH synchronisation list is also displayed below the SDH
synchronisation list - this means that the PDH and SDH node are currently
running on independent clocks, and that both priority lists can be altered. To
synchronise the PDH node to the SDH, check the Synchronize PDH to SDH
check box, then click OK; the next time you open the Priorities page, the PDH
priority list will not be visible.

Steps

1. Click Configuration → Synchronization to open the Synchronization
dialogue box.

The Synchronization dialogue box opens.
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Figure 73. The Synchronization dialogue box

2. Select the Priorities tab.

3. Select the SDH Synchronisation Mode: the alternatives are Use
Priorities, Force On, and Hold Over.

Select the SDH Synchronization Mode:
. With Use Priorities, the timing source is selected automatically,

based on the priority and quality of the synchronisation sources.
. With Force On, you can force the use of a particular

synchronisation source; select the source from the pull-down menu.
. Holdover switches the FXC STM to holdover mode (disabling the

Calibrate button).

4. To modify a synchronisation source

Steps

a. Click on a synchronisation source in the SDH Priorities: frame.
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b. Click Modify to access the Modify Source dialogue box.

The Modify Source dialogue box opens.

Figure 74. The Modify Source dialogue box

c. Select the Unit where the interface of the synchronisation source
is located.

d. Select the Quality Determination: Use SSM or Manual.

Select the Quality Determination as follows:
. Select Use SSM if the Quality Determination of the

synchronisation source should be automatically based on the
SSM of the synchronisation source.

. Select Manual to allow the selection of a specific quality
from the list. See the following table for details.

Table 6. Hierarchy of quality levels

Value Description Priority

G.811 Primary reference clock
quality according to G.811

Highest

G.812 Transit Transit slave clock
according to G.812

|

G.812 Local Local slave clock according
to G.812

|

SETS Synchronous Equipment
Timing Source

|
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Table 6. Hierarchy of quality levels (cont.)

Value Description Priority

Do not use The signal should not be
used for synchronisation

Lowest

Note

The quality selection is disabled when Use SSM is selected.

e. Select the Unit.

f. Select the Interface number; the alternatives are 1 or 2.

g. Click OK.

h. Click Apply to apply the settings.

5. To determine the current synchronisation source quality and status,
click the Refresh button to read the priority list from the FXC STM
node.

6. If necessary, view the Active source.

One synchronization source is Active at a time. The active source cannot
be edited – it only shows the current situation.

Further information

If something went wrong and you want to start from a clean dialogue box, click
Default to set the SDH priority settings back to their default status.
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15 Managing cross-connections

15.1 Overview of managing cross-connections

Purpose

A cross-connection defines how the signals are routed between FXC units in a
node.

If there is no cross-connection file available for commissioning the node, the
cross-connections must be created manually with the MetroHub or UltraSite BTS
Hub Manager.

Summary

Cross-connections are created into banks. The node contains two cross-
connection banks. The state of a cross-connection bank can be active or inactive.
Only the cross-connections that are in the active bank are in use in the node.

If you want to start using the cross-connections in the inactive bank, you must
manually activate that bank.

Note

Adding new cross-connections or editing existing cross-connections is
possible only in an inactive bank.

Note

Export the cross-connections from the inactive bank to a file before power
reset, as the inactive bank is cleared from the node memory. Later, the same
file can be imported to the inactive bank to restore the cross-connections.
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You can edit cross-connections and banks only through the Cross-connections
window.

Steps

1. To open the Cross-connections window

Steps

a. Create an online access to the node or an offline access to the
file.

b. Select Configuration → Cross-connections...

The Cross-connections window is divided into two parts. The upper
window includes a cross-connection list view and on the right-hand
side of the window you can find, for example, the buttons for
adding, removing and modifying connections. The lower window
includes a cross-connections graphic view.
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Figure 75. Cross-connections window

There is a list view for both the active bank and the inactive bank.
The list view shows cross-connection related information in text
format. A connection is always presented in one row. You can select
several connections in the list. The view also provides a pop-up
menu to carry out certain functionality for the selected cross-
connection(s). It also provides buttons to carry out cross-connection-
related or bank-related operations.

You can use the graphic view to create cross-connections and also to
show how the selected connection in the cross-connections list view
progresses from one FXC unit to another. The graphic view shows
only one connection at a time.
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Tip

The view also includes a Refresh button which you can use for refreshing the
cross-connection data.

2. To open the Cross-connection Properties dialogue box

Steps

a. Select an active or inactive bank.

b. Right-click the desired cross-connection.

A pop-up menu opens.

c. Select Properties.

Complete details about the selected cross-connection are shown in
the Cross-connection Properties dialogue box.
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Figure 76. Cross-connection Properties dialogue box

While managing a node (NE) with a protected cross-connection in
the active bank, the dialogue box also displays the condition bit
status for Condition 1 and/or Condition 2. In such a case, the
Refresh button is also available for refreshing the condition bit
status. Once the condition bit status is read, the status is also
displayed in the list view of the Cross-connections window for one
or more cross-connections having the same condition(s).
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Figure 77. List view of the cross-connections window

Press the Legend button to see an explanation of the symbols.

Figure 78. Symbols used in the cross-connections window

The condition bit status can also be read for selected cross-
connections in the Refresh bank pop-up menu. The Refresh bank
pop-up menu, which is available for the cross-connections active
bank, refreshes the condition bit status for all the protected cross-
connections in the bank.

3. If you want to add a cross-connection

Then
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See Adding cross-connections and Adding cross-connections in the
graphic view.

Further information

Bypass connections are always bi-directional and the granularity is 2M.
These connections are only available for FXC RRI units.

A fast and easy way to add bypass cross-connections is via the graphical
view in the Cross-connections window. Refer to Adding cross-
connections in the graphic view for more information.

4. If you want to modify a cross-connection

Then

See Modifying cross-connections.

5. If you want to remove a cross-connection

Then

See Removing cross-connections.

6. If you want to create a cross-connection file

Then

See Creating and exporting a cross-connection file.

7. If you want to import a cross-connection file

Then

See Importing a cross-connection file.

Further information

Usability tips for cross-connections:
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. The easiest way to edit an active cross-connection bank is to take a copy of
it to an empty inactive bank, edit the connections there and activate the
edited bank.

. When clicking the settings button you can choose which cross-connection
attribute is displayed in the Cross-connections window.

. Controls, for example, the Q1 EOC channel and MCB/LCB bits, are
shown in the Cross-connections window as reserved capacity. These are
also marked and seen as uni-directional connections, even though they are
bi-directional by nature. It is only a way of marking.

It should be noted that control connections are just indicating the
reservation of the cross-connection capacity, so they cannot be removed or
edited in the Cross-connections window. They are reserving the capacity
from both banks.

When the user chooses to create the EOCs/Sync loop bits, the contents of
both active and inactive bank are validated for possible conflict.

If any conflict is detected, the manager displays a dialogue box with EOC/
Sync loop bits in conflict.

Figure 79. Conflicting cross-connections

The dialogue box provides an option for the user to clear or preserve the
inactive bank contents and to cancel or continue with current selections.
The manager creates the required 2M cross-connections in the active or
inactive bank depending on the user's decision.
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15.2 Adding cross-connections with the Add Cross-
connection Wizard

Summary

Each type of cross-connections supported by the node can be created using the
Add Cross-connection Wizard. The wizard guides you through the different
steps of adding a new cross-connection into an inactive bank. Should you forget a
setting when adding a new connection, the wizard informs you of the mistake.

The first dialogue box that opens is for the first termination point, TX1/RX1, and
the second dialogue box is for the second termination point, TX2/RX2. If the
cross-connection type is protected bi-directional, a third dialogue box opens
allowing you to specify the parameters of the protecting termination point. All
three dialogue boxes are similar in appearance and function.

The last dialogue box of the wizard is the Overview dialogue box, which shows
you the configuration of the added cross-connection. Depending on the type of
connection, you can enter protection information, mask properties or fixed data in
this dialogue box.

Note

You can also create cross-connections in the graphic view of the Cross-
connections window.

Steps

1. Click Configuration → Cross-connections.

2. Select Inactive bank.

3. Select Add to open the Add Cross-connection Wizard dialogue box.

The Add Cross-connection Wizard dialogue box opens.
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Figure 80. The Add cross-connection wizard TX1/RX1 dialogue box

4. Specify the parameters of Tx1/Rx1, the first termination point.

Steps

a. Label the new cross-connection (optional).

Label the new cross-connection by entering its name in the text
field. The name may not exceed 80 characters.

b. Select the first termination point (TX1/RX1): click on the
appropriate Interface symbol.

Select the first termination point by clicking on the appropriate
Interface symbol in the Interface graphical field.
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c. For an FXC RRI flexbus interface, select a channel from the
Channels graphical field.

For an FXC RRI flexbus interface, select a channel from the
Channels graphical field. The Channels graphical field shows the
channels for the interface of the unit as a row of buttons.

Note

If a channel is selected from the free channels available, the appropriate button
is painted in blue. The reserved channels are shown in grey, and cannot be
selected.

d. For an FXC STM-1 optical interface, select the capacity in the
VC-4 frame matrix.

Select the capacity of an FXC STM-1 optical interface in the VC-4
frame matrix. Changes in selection in the matrix are reflected in the
Subsignal identification boxes (K,L,M) and vice-versa.

The K identification box specifies subsignal TUG-3, which can
have a value of 1, 2, or 3. The L identification box specifies
subsignal TUG-3, which can have a value of 1 to 7. The M
identification box specifies subsignal VC-12, which can have a
value of 1, 2, or 3.

e. For the FXC Bridge interface, select one of the PDH/SDH
channels from the Interface (PDH) graphical field, or the
Interface (SDH) graphical field.

Note

If you are modifying cross-connections, perform this step. However, if you are
adding cross-connections, you can ignore this step and move to the next step.

For the FXC Bridge interface, select one of the 20 PDH/SDH
channels from the Interface (PDH) graphical field, or from the
Interface (SDH) graphical field. Both graphical fields show the
channels for the (PDH/SDH) interface of the unit as a row of
buttons.
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Note

If a channel is selected from the free channels available, the appropriate button
is painted in blue. The reserved channels are shown in grey, and cannot be
selected.

f. Select a Cross-connection Type from the drop-down menu.

Select a Cross-connection Type from the drop-down menu. The
default is Bi-Directional. The cross-connection types are explained
in Transmission unit cross-connections.

g. Select the Granularity.

Select the Granularity. The alternatives are 2M, nx64k, 64k, 32k,
16k, 8k, and nx8k. The default value is 2M.

Note

The granularity selection can disable/enable spin control n:. Spin control n: is
enabled if granularity is n x 64k.

h. If the granularity is nx64k or nx8k, select n:.

n: is the coefficient of granularity when the granularity is nx64 k or
nx8k. If the granularity is nx64k or nx8k, select n: (the alternatives
are 1-31 for nx64k and 2-248 for nx8k; the default value is 1 for
nx64k and 2 for nx8k).

i. Select the Timeslot/Bit (if the granularity is not the same as the
interface size).

Click to select the Timeslot/Bit from the Timeslot/Bit matrix, or
from the Timeslot and Bit boxes:
. The time-slot can be 0-31, depending on the availability. The

default value is the least available time-slot. The Timeslot
box is disabled if the selected granularity is the same size as
the interface or if an interface has not been selected.

. The bit can be 1-8, depending on the granularity. For 8k
granularity, the alternatives are 1-8. For 16k granularity, the
alternatives are 1,3,5, and 7. For 32k granularity, the
alternatives are 1 and 5. The Bit box is disabled if the
granularity is >= 64k.
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Changes in selection are reflected in the Timeslot and Bit boxes,
and vice-versa. The selected capacity is shown as painted in blue,
and the reserved capacity is shown in grey and cannot be selected.

5. Click Next.

The Add Cross-connection Wizard - TX2/DX2 dialogue box opens.

Figure 81. The Add Cross-connection Wizard - TX2/DX2 dialogue box

6. Specify the parameters for TX2/RX2, the second termination point.

Steps

a. Select the second termination point (TX1/RX2): click on the
appropriate Interface symbol.
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Select the second termination point by clicking on the appropriate
Interface symbol in the Interface graphical field.

b. Configure any other available settings referring to the relevant
instructions in steps 4-b to 4-i of this procedure.

Configure any other available settings; refer to steps 4-b to 4-i of this
procedure. Depending on the cross-connection, some of the settings
will not be available for TX2/RX2.

7. Click Next.

8. Specify the parameters for the protecting termination point (only for
Protected Bi-directional cross-connections).

Figure 82. The Add cross-connection Wizard - Protecting TX/RX dialogue box
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The Add cross-connection Wizard - Protecting TX/RX dialogue box
will open if the cross-connection type is Protected Bi-directional. Specify
the parameters for the protecting termination point, referring to the relevant
instructions in steps 4-b to 4-i of this procedure.

Click Next to continue.

9. View the settings in the Overview dialogue box.

Figure 83. The Overview dialogue box

The Overview dialogue box shows the configuration of the added cross-
connection. The arrows drawn in the space between termination point
buttons indicate the direction of the cross-connection and its type.

10. Modify any required control settings in the Overview dialogue box.
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Summary

According to the cross-connection type, the required control settings will be
enabled in the Overview dialogue box.

Steps

a. Modify the Condition of the cross-connection (if the cross-
connection type is Protected Bi-Directional).

Figure 84. The Condition dialogue box (enabled only for protected cross-
connections)

Modify the Condition of the cross-connection as follows:

i. Click the Condition button in the Protection Information
frame to access the Condition dialogue box.

ii. Select the Condition type for the protected connection. The
default value is Priority, which specifies a direct switch
(revertive). Equal specifies a best signal source selection
(non-revertive).
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Note

An Equal condition type has two tabbed pages in the dialogue box. A
Priority condition type has one tabbed page in the dialogue box.

iii. Modify the condition settings in the Condition 1 and/or
Condition 2 tab.

i. Select an FXC card.

ii. If the unit is an FXC RRI, select a Flexbus (1 or 2) and
Channel1 to 4).

iii. If the unit is not an FXC RRI, select an Interface (1 to
4 for FXC E1(/T1), 1 to 20 for FXC Bridge).

iv. Select a Timeslot in the FXC unit (1 to 31; the default
value is 1).

v. Select a Bit in the FXC unit (1 to 8; the default value is
1).

vi. Set the Polarity (0 or 1; the default value is 0.)

Note

‘Local’ (valid inside the 2 Mbit/s signal) or ‘Global’ (valid inside the whole
node) common conditions are not supported in MetroHub or UltraSite BTS
Hub protected cross-connections.

Note

You can use the same condition bit for different protected cross-connections.

Note

If you need to create several protected connections with common condition
data, you can store the condition data by clicking Save As Default. The data is
saved for the duration of the session and it is always taken into use by default
for new protected connections.

iv. Click OK.

b. Adjust the Mask Properties controls (if the cross-connection
type is Bi-Directional Masked).
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Adjust the Mask Properties controls as follows:
. Select the mask Type; the alternatives are AND or OR. The

default choice is AND.
. Enter a bit pattern to use as a mask for the cross-connection in

the Bits edit box. The number of bits depends on the
granularity.

c. Adjust the Fixed Data control (if the cross-connection type is
Uni-Directional Fixed Data).

Enter a bit pattern in theBits edit box of the Fixed Data frame.

11. Click Finish.

Expected outcome

The cross-connection is successfully added.

15.3 Adding cross-connections in the graphic view

Summary

A fast and easy way to add cross-connections is via the graphic view in the
Cross-connections window. You can select the unit, physical interface, and
granularity, as shown in the figure below.

Figure 85. Selecting interface and granularity in the graphic view
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Steps

1. Press down the left mouse button to select an interface.

2. Drag the line to the second termination point and release the mouse
button.

A pop-up menu is displayed.

3. Select the granularity.

The Cross-connection wizard opens.

4. On the first page of the wizard, select the cross-connection type and
the parameters of Tx1/Rx1, the first termination point.

On the first page of the wizard, select the cross-connection type and the
parameters of Tx1/Rx1, the first termination point. For information on
individual settings, refer to Adding cross-connections with the Add cross-
connections wizard.

5. Click Next.

6. Select the parameters of Tx2/Rx2, the second termination point.

Select the parameters of Tx2/Rx2, the second termination point. For
information on individual settings, refer to Adding cross-connections with
the Add cross-connections wizard.

7. Click Next.

8. Click Finish.

15.4 Modifying cross-connections

Purpose

You can modify existing cross-connections.

Steps

1. Click Modify in the Cross-connections window.
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TheModify Cross-connection Wizard opens. The layout of this wizard is
exactly the same as in the Add Cross-connection Wizard (see Adding
cross-connections with the Add Cross-connection Wizard).

Figure 86. The Modify Cross-connection Wizard - TX1/RX1 window

Note

In the connection mode, only connections in the inactive bank can be edited.
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In order for the modified cross-connections to take effect, you must
activate the bank manually. For instructions, see Managing cross-
connection banks.

2. Modify the settings as desired.

Modify the settings as desired. For information on the settings, see Adding
cross-connections with the Add Cross-connection Wizard.

Further information

You can also modify cross-connections via a pop-up menu. Right-click the
selected cross-connection in the inactive bank.

15.5 Creating and exporting a cross-connection file

Steps

1. Open the manager and start the file mode by selecting File → New.

2. Install the desired FXC units in the Equipment window.

Note

To restore the settings stored in a previously exported node (or cross-
connection ‘xcs’) file, the hardware configuration of the node/xcs file must
match the hardware configuration of the node where it will be restored.

3. Open the Cross-connections window by selecting Configuration →
Cross-connections.

The Cross-connections window opens.
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Figure 87. The Cross-connections window

4. Create all needed connections into an inactive bank.

See Adding cross-connections with the Add Cross-connection Wizard.

5. Click Activate to activate the inactive bank with the newly created
cross-connections.
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6. Click the Export button in the Cross-connections window.

The Export dialogue box opens.

Figure 88. The Export dialogue box

7. Save the exported file in the desired location.
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15.6 Importing a cross-connection file

Steps

1. Connect to the node or open a file.

2. Select Configuration → Cross-connections.

The Cross-connections window opens.
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Figure 89. The Cross-connections window

3. Select the inactive bank.

4. Click the Import button in the Cross-connections window.

The Import dialogue box opens.
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Figure 90. The Import dialogue box

5. Select the desired file.

6. Click the Open button.

Expected outcome

The file is imported to the inactive cross-connection bank.

186 (309) # Nokia Corporation DN05168119
Issue 3-0 en

Commissioning UltraSite EDGE BTS



Note

Cross-connections can only be imported to the inactive bank. For the imported
settings to take effect, the bank has to be activated.

15.7 Managing cross-connection banks

Summary

Cross-connection banks can be activated, copied, and cleared.

Steps

1. If you want to activate an inactive bank

Then

Click Activate in the Cross-connection view.

2. If you want to copy an inactive bank

Then

Click Copy in the Cross-connection view.

This creates a copy of the cross-connections from an active bank to
inactive bank. This is useful if you want to create another cross-connection
bank with only minor differences from the original.

3. If you want to clear an inactive bank

Then

Click Clear in the Cross-connection view, or select all cross-
connections in the bank and click Remove.

This removes all cross-connections from the inactive bank.

15.8 Removing cross-connections

Purpose

You can permanently remove a cross-connection from an inactive bank.

DN05168119
Issue 3-0 en

# Nokia Corporation 187 (309)

Managing cross-connections



Steps

1. Select the connection or connections you wish to delete.

2. Click Remove in the Cross-connections window.

Before removing the cross-connections, the manager asks you to confirm if
you want to go ahead with the removal. After you have confirmed the
removal, the manager removes the cross-connection(s) from the bank.

Further information

You can also remove cross-connections via a pop-up menu. Right-click the
selected cross-connection in the inactive bank.

15.9 Forcing an SDH protection switch group

Purpose

With a protected cross connection (protection group) configured, you can force
the working path to protecting or protected.

The force protection switch command will be active until an automatic protection
switch mode is selected, or until the unit performs a reset and the protection
switch mode returns to automatic by default.

The current working path can be determined by the green point displayed in front
of the working path in the cross-connection list.

188 (309) # Nokia Corporation DN05168119
Issue 3-0 en

Commissioning UltraSite EDGE BTS



Summary

Figure 91. Forcing a protection switch group

Steps

1. Select Configuration → Cross-connections.

2. Right-click at the SDH protection group, and select the Protection
Switch menu.

3. Select either Automatic, Force to Protected, or Force to Protecting.

Select one of the following options:
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. Automatic. In case of failure at the protected path, a switch will
automatically occur, to the protecting path. The protecting path will
now be used until a failure in this path occurs and a switch to the
protected path takes place.

. Force to Protected. The working path is forced to be the protected
path. Check that the protected path is working without any alarms
shown. The protected path will continue as the working path, despite
the failures.

. Force to Protecting. The working path is forced to be the protecting
path. Check that the protecting path is working without any alarms
shown. The protected path will continue as the working path, despite
the failures.

Note

If you selected a Force to Protected or Force to Protecting path was
selected, a "Forced Control On" alarm will be raised to notify that the
transmission path is not longer protected. When switching back to automatic
mode, the alarm will be cleared.

Expected outcome

A confirmation window is displayed to confirm that the selected action was
successfully performed by the node.
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16 Administering UltraSite BTS Hub

16.1 Administering user access level control

Purpose

The procedure below instructs how to add users to the Nokia BTS_Admins user
group.

Before you start

Check that you have administrator's rights for the Windows operating system
(OS). Administering user access level control is only possible with Windows
operating system administrator rights.

Steps

1. In the Windows OS, click Start → Settings → Control Panel →
Administrative Tools → Computer Management → Local Users and
Groups → Groups.

2. Double-click Nokia BTS_Admins.

The Properties dialogue box opens.

3. In the Properties dialogue box, click Add.

The Select Users or Groups dialogue box opens.

4. Add users or user groups according to your needs.
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Tip

You can also create a domain user group called Nokia BTS_Admins. With
domain groups, it is possible to manage the access rights by adding users to
the domain group only.

5. Click OK.

16.2 Starting the node manager

Before you start

Nokia node managers have been installed in your computer.

Steps

1. Start Windows.

2. Click Start, and then point to Programs → Nokia Applications.

3. Click the node manager.

Expected outcome

When the node manager is started, an application window appears. The
application window gives you access to all the other windows in the manager. No
other windows are initially open.

The node manager application window has a toolbar that provides short-cuts to
frequently needed menu commands. The window also has a status bar, which
displays:

. connection parameters

. help information on the currently selected menu command

. COM-port that is currently connected

. if the application is running in file mode or connected mode
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16.3 Using online help

Purpose

Nokia node managers feature comprehensive context-sensitive online help that
provides help on all aspects of using the manager. Help is available at any time
when you are using the manager.

Steps

1. Give the menu command Help → Help Topics.

Or

Press the F1 button.

Or

Click the Help button of a dialogue box.

Expected outcome

The manager opens the Help Topics window.

The manager displays the context-sensitive help of the current dialogue
box.

Further information

The context-sensitive help describes only the purpose and the layout of the
dialogue box or window in question. If you want to find more information
about the node manager functions, it can be viewed by clicking the Help
Topics button and then selecting the Contents tab and double-clicking the
topic.

2. Select a topic from the Contents or the Index.

Expected outcome

The selected topic is displayed.

Further information

The FXC unit-related online help is available from Help → Transmission Unit
Managers. The help covers all the FXC units.
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For further information on using online help in Microsoft Windows, refer to the
Microsoft Windows user manuals.

16.4 Using the licence manager

Purpose

In the Licence Manager dialogue box you can maintain the software feature
licences in the network element. You can, for example, view licence files in the
network element and select files to be removed.

Note

The licensed features are modulation, accessed via the RRI settings, and the
Flexbus capacity of the FlexiHopper (Plus) radio.

Note

Modification of data is possible only with Full Control. For more information,
see Enabling user access level control.

Steps

1. On the menu, select Configuration → Licences.

The Licence Manager dialogue box opens:
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Figure 92. Licence Manager dialogue box

The dialogue box contains a list of all licence files in the previously
selected unit. A list of features contained in the licence file is displayed for
each licence file.

2. To install a licence:

Steps

a. Ensure that the licence file folder path is set to the correct
location in the Licence file folder text field.

You can browse the files by clicking the Browse button next to the
text field.

b. Click the feature to be installed.

c. Click the Install button to download the licence file to the
network element.
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3. To remove a licence:

Steps

a. In the Licence Manager dialogue box, click the Files button.

The Delete licence files dialogue box opens. You can view the
currently installed licence files in the network element.

Figure 93. Delete licence files dialogue box

b. In the Delete licence files dialogue box, select the file to be
removed.

c. Click Delete.
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Expected outcome

A licence file is installed or removed.

16.5 Overview of connecting to the transmission node
online

Purpose

Nokia MetroHub or UltraSite BTS Hub Manager offers two ways to work: online
and offline. In the online mode you can manage an actual node and all changes
are made directly to the node. The offline mode allows you to manage a virtual
node.

Note

You cannot fully manage the node in the offline mode. For example, not all
settings can be modified.

Before you start

Start Hub or MetroHub Manager. Select the node that you want to manage by
establishing a connection to the FXC unit acting as the node control unit. This
may be done in three alternative ways:

Steps

1. Connect to the transmission node via LMP.

Or

Connect to the transmission node via Q1 address.

Or

Connect by launching the HubManager from the NetAct Top Level User
Interface.

When launching the HubManager from the NetAct Top Level User
Interface, the application connects to the network element using the
connection parameters stored in the GCS database.
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Further information

Accessing the node remotely via NMS

Security in Hub or MetroHub Manager is governed by the operating environment
of the manager.

. Windows NT4.0 / Windows 2000

When using an NMS system for remote management, the user must have
the proper rights. To access a node manager, a user has to have the
appropriate privileges in NetAct and Node Manager Server.

. Windows 95 and 98

Hub and MetroHub Manager do not support NMS use in Windows 95 and
98.

16.6 Connecting to the transmission node via LMP

Before you start

Ensure that the LMP cable is connected.

Steps

1. Select Connection → Connect Locally.

Note

This menu command can only be used if the local management port is used.

Expected outcome

The manager connects to the node control unit (any FXC unit in slot 1)
using the fixed LMP address 4080 (default port settings: COM1, speed:
9600; these settings can be changed in the Local Connection folder which
is opened by selecting Tools → Options...).

When the connection to the node has been established, the Equipment
window opens automatically.
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Figure 94. MetroHub or UltraSite BTS Hub Manager Equipment window
(Connected to node)

The window presents a schematic overview of the node. You can select a
unit by clicking it. When an FXC unit or an outdoor unit is selected, a unit-
specific menu appears on the menu bar, on the left side of the MetroHub or
UltraSite BTS Hub Manager Tools menu. Outdoor units are managed
through FXC RRI units.

Note

Closing the Equipment window causes the connection to the node or file to
be lost.

The status of the units is indicated by means of colour coding.
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Table 7. Colour codes indicating the status of units

Colour code Status of unit

Dark grey Empty slot

Diagonal stripes Physically inserted, logically uninstalled

Light grey Physically inserted, logically installed
(=operational unit)

Dark grey with a light grey border; type of
unit indicated

Physically removed, logically installed
(=missing unit)

Light grey with a red border; type of unit
indicated

Physically inserted, wrong unit logically
installed (=mismatched unit)

Light grey with a blue border; type of unit
indicated

Software version mismatch. The unit's
software is not compatible with the master
unit's software.

Non-FXC units have to be ‘installed’ in order to be operational. By default,
the following units are in use: power supply unit (on the left), power
interface panel, fan unit, and interface unit.

Further information

If several nodes are chained via LMPs, the connection must be established as
described in Connecting to the transmission node via Q1 address.

For information on installing and uninstalling the units logically with the
manager, see Installing and uninstalling transmission units logically with the
manager.

16.7 Connecting to the transmission node via Q1
address

Purpose

The MetroHub or UltraSite BTS Hub node can also be accessed via the Nokia
Connection Tool.

Steps

1. Select Connection →Connection Tool...

The Connect to Node dialogue box opens.
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Figure 95. Nokia Connection Tool (Connect to Node dialogue box)

2. Define the needed parameters.

Or

Select a previously configured connection.

Further information

Detailed information on using the Nokia Connection Tool is available in
General Communication Service User’s Manual.

3. Fill in the LMP or Q1 address of the equipment to the Q1 Address
field, depending on the connection used.

Further information

If the LMP is chained, a unique Q1 address must be selected for the LMP,
and the connection to the node is established with the Connection Tool...
option in the manager.

4. Click Connect.
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16.8 Connecting to the transmission node offline

Purpose

The offline mode allows you to manage a virtual node. All the information is
saved in a file in your computer and this file represents an image of a real node.

By using this feature, it is possible to create a template which may be used to
commission numerous installations with similar configurations. You can also use
this to make changes to an installation while at the office before going on-site.

Summary

You can connect to the node offline either by creating a new virtual node offline
file or by opening an existing file. For instructions on how to create a new node
file, see the MetroHub or UltraSite EDGE BTS documentation set.

Steps

1. To open an existing file

Steps

a. Select File → Open...

b. Select the file to be opened.

c. Click Open.

Further information

When in the offline mode, MetroHub or UltraSite BTS Hub Manager does not
verify the entered configuration. The configuration is verified with the actual
equipment when it is sent to the node. If the created configuration does not
correspond to the actual installed equipment, a warning is displayed.
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Figure 96. MetroHub or UltraSite BTS Hub Manager Equipment window (offline
mode)

16.9 Resetting the transmission node or units

Purpose

Resetting a node is an exceptional situation in normal operation, but when the
network is initially built, a situation may occur when resetting the node is
necessary. Generally, there are two kinds of resets: one for the whole node and the
other for a single transmission unit. All resets can be given using the node
manager.
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In the Resets dialogue box you can select the type of reset and the targeted units.
The reset dialogue box is only accessible in the connected mode and factory
settings are only allowed in LMP connections. Hardware resets are possible for
all units.

The node settings are not unit-specific settings maintained by the master unit like
the cross-connection settings. Factory reset restores the default factory settings
but the connection speed for LMP remains unchanged. The factory reset is
automated when you start the Commissioning Wizard or restore backup settings.

Steps

1. Select Maintenance → Resets.

The Resets dialogue box opens.

Figure 97. Resets dialogue box

Further information
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In this dialogue box you can select which part of the UltraSite BTS Hub or
MetroHub to reset. Selecting a unit resets the corresponding unit, and
selecting the node resets the master unit of the node. When the command is
sent to the node, UltraSite BTS Hub or MetroHub carries out the desired
resets.

There are two different kinds of node resets:
. Hardware

This reset equals hardware reset to a power off/on of transmission
units. The traffic is cut and all settings remain unaffected. In case of
a hardware reset to the node, the selection is disabled because a reset
is always executed for each unit.

. Factory defaults

This reset restores the node to its original settings. For a node
selection, all node settings (cross-connections, synchronisation,
EOC and so on) are deleted. If a unit is selected, the unit settings are
deleted. After the settings have been deleted, the corresponding unit
is reset and the default settings are taken into use. There are,
however, few settings that are not reset, these are:
. connection speed for the LMP port
. node and unit identification settings
. Flexbus power and capacity settings

2. Select the units to be reset.

3. Click Send.

Expected outcome

If you select all units, the resets are executed in the following order:

1. Reset of the outdoor units.

2. Reset of the FXC units.

3. Waiting for the master unit to recover.

4. Reset of the node.

5. Waiting for the node to recover.

6. The initial value for LMP speed is restored.
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16.10 Saving node information in a file

Purpose

Node information can be saved in a file for later use both online and offline.

The file can be used in commissioning the node.

Before you start

The Equipment view is open.

Steps

1. Select File → Save... or Save As...

The manager opens the Save Node Settings dialogue box.

Figure 98. Save Node Settings dialogue box

2. Select either Select all or select the individual units that you want the
settings to be saved for.
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Note

Node settings are always saved.

When a particular RRI is selected, all OUs connected to it are automatically
selected (and cannot be unselected). Thus, the settings of the OUs are
automatically saved along with those of the corresponding FXC RRI.

3. Click OK.

The manager opens the Save As dialogue box.

4. Give the file a name and select a file type.

5. If you want to edit the file header

Then

Click the Edit button to access the File Header Edit dialogue box, then
edit the header.

Click the Edit button to access the File Header Edit dialogue box. Edit
the header as follows:
. Adjust the Date if necessary, from the pull-down menu, or click <-

Now to enter the current date.
. Fill in the User Name and User Comment fields, if required.

Once you have edited the header, click OK to the return to the Save As
dialogue box.

6. Click Save.

Expected outcome

The file is saved.

Further information

Changes to alarm properties are not saved with the node file.

When you save node information, FXC STM-1 unit settings and FXC RRI unit
settings are also saved automatically (if those units are present). This is because
node parameters are also distributed over these units, and those parameters must
be available for backup or commissioning purposes.
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UltraSite BTS Hub or MetroHub supports two site configuration file formats, .
nod (for node offline file) and .xml. It is also possible to read older node files with
the extension .dat.

16.11 Restoring backup settings from a file

Purpose

It is possible to save node and unit settings into a backup file (both extensions .
xml and .nod), see Saving node information in a file. The backup file can be used
in restoring backup settings of the node or the units.

Before you start

To be able to restore backup settings, the user must have a backup file. It is
recommended to make a backup file (in .nod format) after a node has been
commissioned and it has been verified that it functions as planned.

Note

Previously the backup file has been saved in .dat format. A file in .dat format
can still be used, but all new backup files as well as old .dat files that have
been modified are saved in the .nod format.

The backup dialogue box is only accessible in the connected mode.

Note

Before restoring the settings at the node level, the node must be in the factory
defaults state. If it is not, the factory settings are restored automatically.

Steps

1. Select Maintenance → Restore Backup Settings.

The Restore Backup Settings dialogue box opens.
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Figure 99. Restore Backup Settings dialogue box

2. Click Browse...

The manager opens the standard Windows open file dialogue box.

3. Browse to the file, select it and click Open.

The file is opened in the backup dialogue box, and the manager type and
unit configuration is checked.
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Figure 100. Restore Backup Settings dialogue box

If the file contains correct data for the unit, the settings can be sent to the
selected units.

If the file contains data that does not match to the configuration of the
node, the manager gives a note and the user has to select a file containing
the right configuration.

4. Select the units that you want to send the file to.

5. Click Send.

Expected outcome

The manager sends the settings to the selected units. During sending, the manager
displays a progress dialogue box. When the settings have been sent, the dialogue
box is closed.

Further information

When you restore node settings from a backup file, FXC STM-1 unit settings and
FXC RRI unit settings are also restored automatically (if those units are present).
This is because node parameters are also distributed over these units.
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16.12 Creating a configuration report

Summary

The configuration report contains all the configuration information of the
connected Nokia MetroHub or BTS transmission Hub.

Steps

1. Select Tools → Reports → Configuration Report.

The Configuration Report window opens.

Figure 101. Configuration report

The configuration report contains all the configuration information of the
connected Nokia MetroHub or BTS transmission Hub. You can also
modify the contents of the configuration report.

2. Modify the contents of the configuration report.

Steps

a. Click the Options button.

DN05168119
Issue 3-0 en

# Nokia Corporation 211 (309)

Administering UltraSite BTS Hub



The Configuration Report Options dialogue box opens.

Figure 102. Configuration Report Options dialogue box

b. Select what to include in the report.

Further information

The following options exist:
. Power, Fan. When selected, the information on the power and

fan units are included in the report.
. Detailed Unit Identification. When selected, the hardware/

software configuration part of the report contains information
on the hardware and software versions.

. Synchronisation. When selected, information about node
synchronisation is included.

. Q1 Management and Service IF. When selected, the report
includes information on Q1 management and service interface
of the node.

. Cross-connections. When selected, the report includes
information on cross-connections.

. D-bus allocation. When selected, the report includes
information on D-bus allocation. (Valid only in Nokia
UltraSite BTS Hub Manager.)
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. EAC and Alarm Config. When selected, the report includes
information on EACs and alarm configuration.

. Include Alarms in Report. When selected, the report includes
information on active alarms.

. Line IF (LIF) and Platform IF (PIF). When selected, the report
includes information on LIF and PIF.

. Radio Settings. When selected, the report includes
information on outdoor units (radios) of the FXC RRI units.

Note

These selections are not saved when you close the Configuration Report
dialogue box.

c. Click OK.

3. Click Save to open the Save As dialogue box.

Note

If you have not entered the Site Name in the Hardware Identifications
dialogue box (Node Identifications tab), the Node Identifications tab will
appear. Enter the Site Name and click OK.

4. Save the .cnr file to a suitable location.

Expected outcome

The configuration report is saved as a text file with the extension .cnr and has to
be opened with a text editor.

16.13 Printing information

Summary

You can print information from Equipment, Cross-connections and Alarm
windows.
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Steps

1. Open the window which you want to print information from.

2. Select File → Print.

3. Adjust the settings in the Print dialogue box as required.

4. Click OK to print.
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17 Configuring the BTS for manual
commissioning

17.1 Creating a new hardware configuration

Summary

The hardware configuration is defined with the BTS HW Configurator.

The quickest way to create a new BTS HW configuration is to run the Wizard
(Configuration | Wizard). The Wizard takes you through the task sequence in the
correct order and provides instructions for each task. Additional information is
available through the Help button.

If there is not a predefined hardware configuration file available for the BTS, you
can create the configuration with the Create New Configuration option in the
Wizard. Creating a new configuration with the Wizard does not require a BTS
connection, so you can create the configuration in advance and save it as an .hwc
file.

The Passive Units view in the BTS HW Configurator allows you to enter
information concerning all units that are not autodetected. This information
includes part and serial numbers. This information is not required during
commissioning and is not needed to get the BTS operating. It is possible to enter
and update this information any time before, during, and after commissioning.

You can enter passive unit information with the BTS HW Configurator offline
and online. You can also use a barcode reader to scan the part and serial numbers
off of stickers on the units. The software recognizes the part number and
identifies the unit type. One problem is that using a barcode reader with the PC
requires the use of one serial port, and many laptop computers have only one
serial port. In this case, you must use the BTS HW Configurator offline to scan
the part and serial numbers. Once this is completed and the information is saved
to a file, the hardware information file (.hwi) can be downloaded to the BTS.
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Note

If you change the hardware configuration in any way after the BTS
commissioning has been finished, you will have to perform a BCF reset to
activate the changes.

Steps

1. Open the BTS HW Configurator.

Select Nokia BTS HW Configurator from the Nokia Applications submenu
in the Start | Programs menu in Windows.

2. Start the HW Configurator Wizard.

Select the Wizard command on the Configuration menu.

3. Set up the new configuration.
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a. Select the Create New Configuration option from the Configuration
Wizard window and click Next.

Figure 103. New Configuration Wizard welcome page
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b. Select <New> from the Sector Configuration window list and
common network type from the drop-down list.

Figure 104. Sector Configuration

c. If you want to change the network type of individual TSx units,
click Modify.

Or

Alternatively, you can select one of the predefined configurations from the
Modify Sector and Network list to be modified further.
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Figure 105. Modify Sector and Network configuration dialog box

4. Define the TSx configuration on the Define TSx Configuration
window.
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Figure 106. Define TSx Configuration

a. Select the TSx unit from the Define TSx Configuration window list.

b. Select the basic configuration for the selected TSx unit from the
Configuration Type drop-down list.

Note

Select from the following configuration types:
. Bypass with DDU stands for one TSx unit connecting to a

DDU half.
. 2-way DDU stands for two TSx units connecting to a DDU

half.
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. 4-way DDU stands for four TSx units connecting to a DDU
half.

. RTC stands for six TSx units RTC.

c. Click Set for each TSx unit selected.

d. Click Next.

5. Define RX diversity for each TSx unit on the Define RX Diversity
Cabling window.

Figure 107. RX Diversity Cabling

a. Select the TSx unit from the Define RX Diversity Cabling window
list.

b. Select the combiner unit for the selected TSx unit from the drop-
down list.
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c. Click Set to update the defined cabling configuration.

d. Click Next.

6. Define antenna settings in the Define Antenna Settings window.

Figure 108. Antenna Settings

a. If all antennas use high-gain MHAs and/or VSWR monitoring,
select the corresponding options in the Properties for All Connected
Antennas group box of the Define Antenna Settings window.

Note

All UltraSite-specific MHA (MNxx) units are high-gain type. All other MHA
units are low-gain type.

b. Select an antenna in the Antennas list.

c. Select a unit for the selected antenna from the DVx/RTx list.
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d. Click Set to update the defined antenna information to the
configuration.

e. Click Next.

7. Verify report on Report of New Configuration window and exit
Wizard.

Figure 109. New configuration report

Verify the new configuration report and click Finish to exit the Wizard.

You can modify the configuration manually through the Properties pages
after the Wizard is closed.

8. Save the new configuration.

Save the new configuration to the hard drive by selecting Save from the
File menu.
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Note

Before saving the new configuration to a file, you can manually make changes
to the unit properties, if necessary.

Or

Alternatively, send the configuration information to the BTS from the BTS
menu using the Send BTS Configuration command.

9. Proceed to the Overview of using Hub Manager of Site Wizard.

17.2 Using an existing hardware configuration

Before you start

This procedure requires a predefined hardware configuration file (with file name
extension .hwc). For more information, see Creating a new hardware
configuration.

Note

Creating a new configuration with the Wizard requires no BTS connection, so
you can create the configuration in advance and save it as an .hwc file. A BTS
hardware configuration file (Basic Configs.hwc) with basic BTS
configurations is delivered with Nokia BTS HW Configurator. You can use
the configurations as such, if possible, or you can modify them to suit your
purposes.

Summary

Hardware configuration information is defined with BTS HW Configurator.

Steps

1. Open the BTS HW Configurator.

Select Nokia BTS HW Configurator from the Nokia Applications submenu
in the Start | Programs menu in Windows.

2. Start the HW Configurator Wizard.
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Select the Wizard command in the Configuration menu.

3. Retrieve the desired HW configuration.

a. Select the Check BTS Configuration and Update BTS option from
the Wizard Welcome window.

Figure 110. Wizard welcome page

The Wizard automatically displays the BTS HW configuration file
that was used last.
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b. Select the BTS to be configured in the Select Configuration window.

Figure 111. Select Configuration

c. Click Next.

4. If the configuration you want is not in the list,

Then

Locate the appropriate configuration file.
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a. Click Browse to load the appropriate .hwc file.

b. Click Next.

c. If the BTS connection is not enabled, the BTS HW Configurator
asks if you want to activate it.

Note

The BTS connection requires that the LMP cable is connected from the PC to
the BTS. For more information, see Connecting LMP cable for
commissioning.

5. Ensure that the configuration information is correct on the BTS
Connection window.

The BTS Connection Status list displays information about the BTS
connection and the state of the BCF.

Click Next when the BCF is in the correct state.
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Figure 112. BTS Connection

6. Verify other associated information in the Cabinet Information
window.

You can view information concerning the BTS cabinet type, clock
synchronisation, and Line Terminal Equipment (LTEs) in the Site Support
cabinet.

When finished, click Next.
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Figure 113. Cabinet Information

7. Verify cross-connections on the BB2-TSx Cross-connections window.

Verify the BB2 cross-connection to the TSxx units.

When finished, click Next.
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Figure 114. BB2 connections

Note

If there are units that have not been detected automatically, click Autodetect.
The BCF must be in the BCF Commissioning state. You can select the View
Autodetected Units option to see the autodetected units in the Graphical view
in BTS HW Configurator.
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Note
. BSS 9 - All BSS 9 features can be used with the CX3.0/3.3 SW

releases and the current SW release PU1.0-3 with the cross-
connection functionality in case existing equipment has not been
configured to use default connections. However, Nokia recommends
that sites are reconfigured so that the cross-connection functionality
is not used, especially if technical problems occur.

. BSS 10/10.5 - The cross-connection functionality is not supported in
CX3.0/3.3 SW releases when the new BSS10/10.5 features are used.
To use these features, you must reconfigure the sites to use default
connections.

. BSS 11 - The cross-connection functionality will be permanently
removed in the CX4.0 SW release.

Note

If a TSx unit does not exist in the configuration, the unit will be in brackets
and greyed out.

8. Verify the TX, RX main, and RX diversity cable connections for TRX1
to TRX12 on the Current Cabling window.

Clicking a cabling option in the list displays the selected cabling in the
Graphical view on the left. The View Settings group box specifies the
appearance of the Graphical view enabling you to show/hide wideband and
multicoupler units and non-active cabling.

When finished, click Next.
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Figure 115. TSx Cable Connections

9. Verify antenna unit connections shown in the Antenna Settings
window.

To enable VSWR monitoring for an antenna,

a. Select the antenna from the list.

b. Select the VSWR Monitoring Enabled option.

c. Click on an antenna in the list to display the corresponding antenna
cable in the Graphical view.
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d. If the MHA type is high gain, change attenuation values, if required.

Note

All UltraSite-specific MHA (MNxx) units are high-gain type. All other MHA
units are low-gain type.

e. Click Next.

Figure 116. Antenna information
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10. Open a HW information file from the Passive Units window.

a. Click the desired folder to expand it and then click the required
hardware unit.

b. Click Import to open the corresponding hardware information file (.
hwi).

c. When finished, click Next.

Figure 117. Passive Unit information

Note

Passive unit information is not needed to make the BTS operational.

11. If you want to save the configuration report to a file,

Then
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Select the location and filename in the BTS Configuration Report
window.

Enter the path and filename in the Save As field or click Browse to specify
the location and filename.

Figure 118. Configuration Report Page

12. Save the configuration information and exit the Wizard.

Click Finish to save the configuration information in the BTS and exit the
Wizard.
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13. Exit the BTS HW Configurator.

14. Proceed to the Overview of using Hub Manager of Site Wizard.
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18 Commissioning with XML Configuration
File

18.1 Commissioning based on an off-line node file

Summary

To commission the BTS transmission with a node file, send the file to the node
during the commissioning procedure with the Nokia UltraSite BTS Hub
Commissioning Wizard. This allows more network setup to be performed offsite.
The site configuration file (.xml extension) is usually provided by network
transmission planning.

Nokia NetAct Transmission Planning Tools do not support all the required
parameters of the BTS needed to fully commission the BTS. Missing settings are
added to the file using UltraSite BTS Hub Manager.

The Unsupported XML parameters table lists the XML parameters that are not
supported by the Nokia NetAct Planning Tools. Obligatory parameters that must
be added are marked with an asterisk.

Table 8. Unsupported XML parameters

Category Parameters

TruNet TruNet Status

IP Address

Site Data

D-bus Allocation Signalling Type

EDAP Allocation
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Table 8. Unsupported XML parameters (cont.)

Category Parameters

Identifications Equipment Name

Group Name

Site Allocation

Node and Unit installation information

Cross-connections Cross-connection label

Q1 Management Q1 group address

Q1 baud rate

Hybrid switches* (‘processor’, ‘internal’,
‘internal to external’ and ‘external’

EOC settings*

Synchronisation Synchronisation sources*

Unit Unit name and installation information

Interface mode* (FXC E1/T1)

Interface name (FXC E1 and FXC E1/T1)

Interface CRC usage*

Operation mode* (FXC RRI)

Radio Hop Information Hop name

Hop frequency*

Hop maximum TX power*

Hop temporary ID*

Hop mode*

Hop accept channels*

Note

One XML file can contain commissioning configurations for many BTS sites.
You can only configure one site at a time with UltraSite BTS Hub Manager.

You can add other elements, such as cross-connections, with UltraSite BTS
Hub Manager, but this procedure assumes that all other necessary elements for
the site are already properly planned with Nokia NetAct Planner.
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Steps

1. Edit the existing XML file, if available, to add unsupported
parameters.

2. If a valid XML configuration file cannot be obtained from transmission
network planning,

Then

Create a node off-line file.

3. Set the obligatory radio settings for FlexiHopper.

4. Set the obligatory radio settings for MetroHopper.

5. Use the off-line node file to commission the BTS Hub node with the
commissioning wizard.

18.2 Editing an XML file

Summary

Note

The detailed instructions of manual commissioning apply for all settings in
this section, except for radio settings. For detailed instructions on creating
radio settings for a node file, see Setting obligatory settings for FlexiHopper
and FlexiHopper Plus and Setting obligatory settings for MetroHopper.

Steps

1. Start UltraSite BTS Hub Manager and open the XML file.

To open the XML file, select File | Open....

2. If the XML file contains many sites,

Then

From the Site Selection window, select the site to be modified.
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Figure 119. Accept Site Selection dialog box

The Equipment View in Nokia UltraSite BTS Hub Manager displays.
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Figure 120. Equipment View in Nokia UltraSite BTS Hub Manager

3. Add or modify the required parameters to the node file.

For a list of unsupported XML parameters, see the table in Commissioning
based on an off-line node file.

4. Save the modified XML Site configuration file.

Select menu File | Save or File | Save As....

5. If you want to modify more than one site,

Then

Save the file after each site modification.

6. Repeat this procedure until you modify all of the required sites.
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18.3 Creating a node off-line file

Summary

If you cannot obtain a valid site configuration file from transmission network
planning, you can create the node off-line file (with .dat extension) and include all
of the necessary settings in the file, as provided by transmission network
planning.

Note

The detailed instructions of manual commissioning apply for all settings in
this section, other than radio settings. For detailed instructions on how to
create radio settings for a node file, see Setting obligatory settings for
FlexiHopper and FlexiHopper Plus and Setting obligatory settings for
MetroHopper.

Steps

1. Open the UltraSite BTS Hub Manager.

Select Nokia UltraSite BTS Hub Manager in the Start | Programs | Nokia
Applications menu in Microsoft Windows.

2. Create a new file.

Select File | New in UltraSite BTS Hub Manager.

3. Install the required FXC units and radios in the Equipment View.
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Figure 121. Equipment View in Nokia UltraSite BTS Hub Manager

4. Perform the necessary settings to the units and the node.

For more information, see Manual Hub configuration (except for the radio
settings).

5. Save the node off-line file.

Select File | Save as....
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18.4 Setting Nokia FlexiHopper and Nokia FlexiHopper
Plus settings

Before you start

Note

Familiarise yourself with the Nokia FlexiHopper with FXC RRI User
Manual's Commissioning and Maintenance document before setting Nokia
FlexiHopper radio settings. Refer to the commissioning instructions in Nokia
FlexiHopper Plus Product Documentation before setting FlexiHopper Plus
radio settings.

Steps

1. Click the FXC RRI unit corresponding to the Nokia FlexiHopper or
FlexiHopper Plus radio in the Equipment View window.

A unit-specific menu appears.

2. Select Settings → Operation Mode on the FXC RRI menu.

The Operation Mode dialogue box opens.
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Figure 122. Operation Mode dialogue box

The operation mode of an FXC RRI unit can be single (no hot standby
(HSB) protection) or 1 IU + 2 OU HSB Protected or 1 IU + 2 OU HSB
Protected + Space Diversity. The Operation Mode dialogue box also
allows the user to select which of the units should be the primary OU,
which is the active protected OU when both OUs are operational.

3. Select the operation mode, and in case of 1 IU + 2 OU HSB or 1 IU + 2
OU HSB + Space Diversity, also the primary OU Tx, and click OK.

When the operation mode of an FXC RRI unit is set to 1 IU + 2 OU HSB
Protected, the protected radio hop is displayed in the Equipment View of
the hub managers.

The protected hop is only visible if the RRI unit has been selected in the
Equipment view. If another unit was selected, the protected hop is not
displayed.
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Figure 123. Protected radio hop in the Equipment View

The far-end outdoor units and indoor unit are shown for each protected hop
together with information on the hop status. The status information
includes:
. an arrow representing the receive status of each OU:

. Green arrow = receiving at an acceptable level

. Red cross over the arrow = not receiving
. numbers displaying the receive level of each OU in dBm, and
. text “Tx” and/or “Rx” beside each OU representing the currently

active transmitter and receiver.

4. Select Settings→ Outdoor Unit on the FXC RRI menu corresponding
to the Nokia FlexiHopper or FlexiHopper Plus radio.

The settings dialogue box opens. The same dialogue box is used for Nokia
FlexiHopper and FlexiHopper Plus, but the options vary.
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Figure 124. Nokia FlexiHopper or FlexiHopper Plus settings, single

In hot standby mode, the Flexbus capacity and OU settings are common
for both radios, except for the Maximum Tx power and ALCQ / ATPC set
point settings.
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Figure 125. Nokia FlexiHopper or FlexiHopper Plus settings, HSB protected

5. Set the Tx frequency.

Use the Tx frequency provided by radio frequency planning.

6. Set the maximum Tx Power.

This value is also provided by radio frequency planning. The value is
dependent on the frequency band. For example, for a 38 GHz frequency
band radio, the maximum allowed value is 16 dBm.
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7. Set the Tx power ON.

8. Set the ALCQ (Adaptive Level Control with Quality Measure) or
ATPC (Automatic Transmit Power Control).

If needed, ALCQ/ATPC can be switched on after the hop has been
commissioned and the fine-alignment of the antenna has been performed.
The Rx input level, determined by the radio frequency planning, must also
be correct.

9. For the ALCQ/ATPC to function, set the ALCQ/ATPC set point value
(dB).

This value can be calculated by radio frequency planning.

10. If the installation includes a Nokia FlexiHopper Plus

Then

Set the Modulation.

The 16-state mode is available for Nokia FlexiHopper Plus outdoor units
with 8x2M and 16x2M capacities. Compared to using Nokia FlexiHopper,
it is possible to achieve the same capacity using only half the bandwidth.

Note

16-state mode requires a software license. To use 16-state mode, license the
feature via the Licence Manager dialogue box. For more information, see
Using the licence manager.

Note

For a link to be established, the same modulation has to be used at both ends
of the radio hop. Changing the modulation resets the radio and interrupts
management traffic for one minute.

Further information
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The Nokia FlexiHopper Plus supports higher modulation, which translates
into higher density in terms of bandwidth for the existing channels.
FlexiHopper Plus is fully compatible with FlexiHopper. However, to
benefit from the increased capacity, it requires a FlexiHopper Plus at both
ends of the radio link, that is, both radios have to support the 16-state
setting.

In hot standby mode, the modulation selection is common for both radios.
If one of the radios is a FlexiHopper, then both radios will have to use the
4-state setting, which is the only setting supported by FlexiHopper.

For more detailed information, refer to Nokia FlexiHopper Plus
documentation.

11. Set Interleaver Status, if needed.

Possible values for the interleaver status are Off, Depth 2 and Depth 4 in
4-state modulation. In 16-state modulation, the interleaver status is fixed to
Depth 4.

Change the setting accordingly at the other end of the hop (the status must
be the same at both ends of the hop).

Note

The outdoor unit stops transmitting while the interleave status is being
changed.

12. Set the scrambler, if needed.

13. Measure the fading margin by clicking the Measure button.

The Fading Margin Measurement dialogue box opens.
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Figure 126. Fading margin measurement dialogue box

The fading margin measurement (FMM) is an optional part of the radio
hop (single or HSB protected) commissioning process. FMM can also be
executed manually for an already commissioned hop. If far-end indoor unit
type is not supported, the measurement field is grey.
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Note

The measurement interrupts the traffic.

Further information

For single hop, the fading margin is measured for one radio (outdoor unit)
at a time: the measurement result fields for the selected outdoor unit are
enabled (white) and the result fields for the other outdoor unit are disabled
(greyed).

The fading marging measurement is also not supported (it is greyed) if the
HSB + Space Diversity is selected.

The Fading Margin Measurement dialogue box result field can contain
up to three measurement results at the same time from which the most
sensible should be seen as a valid result. The uppermost value is the last
measured.

When the measurement is started, the outdoor units at both ends of the hop
stop transmitting, that is, they both switch to MUTE. Both outdoor units
start their timers, which determine how long they stay in MUTE mode. The
measurement stops automatically after the timers are elapsed.

14. Set the backup/restore settings.

Steps

a. In the Outdoor Unit dialogue box, select the Configuration
Backup tab.

The Configuration Backup view is displayed:
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Figure 127. Configuration Backup tab

b. If you want to set the automatic backup on

Then

Check the Automatically backup unit settings check box.

If this check box is checked, the system saves the settings for the
indoor unit each time they are changed.

c. To backup the settings immediately, click the Backup settings
now button.
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The current settings are saved for the indoor unit.

d. To restore the settings immediately, click the Restore settings
now button.

Click the Restore settings now button when the settings have been
changed and you want to revert to the previous settings.

Manually stored settings are restored.

15. Click the OK button.

18.5 Setting Nokia MetroHopper settings

Before you start

Note

Familiarise yourself with the Commissioning and Maintenance documents in
Nokia MetroHopper with FXC RRI User Manual before setting Nokia
MetroHopper radio settings.

Steps

1. Click the FXC RRI unit corresponding to the Nokia MetroHopper
radio in the Equipment View window.

A unit-specific menu appears.

2. Select Settings→ Outdoor Unit on the FXC RRI menu corresponding
to the Nokia MetroHopper radio.

The settings dialogue box opens.
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Figure 128. Nokia MetroHopper's RF settings for the outdoor unit in FXC RRI

3. Click the Commissioning settings tab.

The commissioning settings dialogue box opens. This tab is only visible in
the offline mode.

Figure 129. Nokia MetroHopper's commissioning settings for the outdoor unit in
FXC RRI
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4. Set the Hop Mode.

One end of the hop must be set as the master and the other end as the slave.

5. Set the Temporary Hop ID.

This value must be the same for both the master and the slave.

6. Select channel spacing.

When the channel spacing is changed, the automatic channel selection list
is updated accordingly. Changing the spacing mode online resets the
MetroHopper OU.

For more information on channel spacing, see Nokia MetroHopper Radio
with FIU 19/FIU 19E User Manual.

7. Use the Select All button to select all channels in the Automatic
Channel Selection.

8. Click the Apply button.

9. Click the RF Settings tab to view the RF settings again.

10. Set the Interleave Status, if needed.

The status must be the same at both ends of the hop.

11. Set the Forced Synchronising Master, if needed.

This check box is available only if you set the Hop Mode as the master in
step Set the Hop Mode.

12. Click the OK button.

18.6 Using off-line node file for commissioning

Before you start

Review Commissioning based on an off-line node file.

Nokia delivers all units with factory settings. If you have already configured the
units, you must restore the factory settings by using Factory Defaults on each
FXC unit. Afterwards, you can run the Commissioning Wizard.
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Steps

1. Open UltraSite BTS Hub Manager.

Select Nokia UltraSite BTS Manager from the Microsoft Windows Start |
Programs | Nokia Applications menu.

Wait until the BTS Manager has properly started and then move on to the
next step.

2. Connect BTS Hub Manager.

Start UltraSite BTS Hub Manager from the BTS Manager’s Tools menu.

The Equipment View in Nokia UltraSite BTS Hub Manager opens
automatically when the connection has been established.

Figure 130. Equipment View in Nokia UltraSite BTS Hub Manager

3. If the connection fails,

Then

DN05168119
Issue 3-0 en

# Nokia Corporation 257 (309)

Commissioning with XML Configuration File



Verify the connection parameters using one of the following actions.
. Select Tools | Options | Manager and verify the connection speed

and LMP cable connection.
. Select Connection | Connect... and verify the connection speed and

LMP cable connection in the Connect to Node window.
. Using the Nokia Connection Tool, refer to the application’s online

Help.

Note

The units must not contain modified settings (such as cross-connections) when
you run the Commissioning Wizard.

4. Open the Commissioning Wizard.

From the menu bar, select Configuration | Commissioning Wizard.

5. Run all Hub tests described in Testing with the Commissioning
Wizard.

6. From the Testing window of UltraSite BTS Hub Commissioning
Wizard, verify the results of the tests and fill in the required fields.

258 (309) # Nokia Corporation DN05168119
Issue 3-0 en

Commissioning UltraSite EDGE BTS



Figure 131. Testing dialog box

7. Click Next to open the Site Selection window.
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Figure 132. Site Selection dialog box

8. Browse the node off-line file.

9. If the file is an XML file (received from NetAct planner),

Then

Select a site from the Site Selection window.

10. Ensure that the selected site is correct.

Click Next to open the Accept Site Selection window.
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Figure 133. Accept Site Selection

11. Accept the node off-line file and the site.

Click Next to accept the selected node off-line file and the site and to send
the node settings to the node.

12. If no FXC RRI units are used,

Then

The End window displays.
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Figure 134. End dialog box

The program then performs the node configuration.

13. If radios are included in the configuration,

Then

The Check Hops window displays.
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Figure 135. Check hops dialog box

This step is optional.

a. Verify and fine-tune radio hops.

b. Click Next when the required hop statuses are OK. The End window
displays.

14. Save Commissioning Report on the End window.

a. Verify the Commissioning Report.

b. Give the file a name.

c. Click Finish to store the report on the disk.
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19 Commissioning the BTS manually

19.1 Manual commissioning

Before you start

Manual commissioning can be performed only with a non-commissioned BTS. If
the BTS to be commissioned is already commissioned, first you need to run the
Undo Commissioning procedure in the BTS Commissioning Wizard.

Summary

The BTS commissioning is performed with the BTS Commissioning Wizard. It is
assumed that the LAPD links and the PCM port are activated at the BSC. The
BCF is still in Locked state.

Note

BTS software is loaded to the BTS by the manufacturer. There is usually no
need to locally load software to the BTS during commissioning.

Steps

1. Open Nokia BTS Manager.

Select Nokia BTS Manager from the Nokia Applications submenu in the
Start | Programs menu in Windows.

2. Start BTS Commissioning Wizard.

From the Commissioning menu, select Wizard. The BTS Commissioning
Wizard window of Nokia BTS Manager displays.
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Figure 136. Manual Commissioning option

3. Select manual commissioning.

Select the Manual Commissioning option and click Next.

4. Enter initial settings for manual commissioning.

5. Verify the BTS Commissioning Report.

266 (309) # Nokia Corporation DN05168119
Issue 3-0 en

Commissioning UltraSite EDGE BTS



Figure 137. BTS Commissioning Report

6. Save the report and exit the Wizard.

Click Finish to save the report and exit the BTS Commissioning Wizard.

7. Exit the BTS Manager.

To quit BTS Manager, select Exit from the File menu.

8. Disconnect your laptop PC from the BTS’s LMP port.

The commissioning parameters are stored in the BOIA memory.
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Note

To start the BTS, unlock it at the BSC.

19.2 Entering initial settings

Steps

1. Enter the following optional information in the Set Transmission
Parameters window of the BTS Commissioning Wizard, and click
Next.
. Site name
. Site ID
. BCF ID
. BSC ID
. IP Address
. Network ID
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Figure 138. Set Transmission Parameters page - FC unit

2. If there is a FC E1/T1 transmission unit in the BTS configuration,

Then

Define the LIF and synchronisation settings.

a. Click LIF Settings to define the line interface (LIF) settings for
manual commissioning of FC E1/T1 units.

b. Click Synchronisation to define the synchronisation settings for
manual commissioning of FC E1/T1 transmission units.

c. When finished, click Next to continue. The Transmission
Configuration window for FXC E1(/T1) unit displays.
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Figure 139. Transmission Configuration page for FXC E1(/T1) unit

Note

If any transmission card other than an FC E1/T1 is used, then LIF Settings and
Synchronisation do not display in the Set Transmission Parameters window.

3. Send commissioning parameters to the BTS.

In the Transmission Configuration window, click Start Commissioning to
send the commissioning parameters to the BTS.

4. If there is an FC E1/T1 transmission unit in the configuration,

Then

Allocate F(X)C transmission capacity.
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The appearance of the Transmission Configuration Wizard window is
different. Click Traffic Manager to allocate FC transmission capacity. This
action establishes a transmission connection between the BTS and the
BSC.

Note

If the connection fails, see Trouble management of BTS commissioning.

Note

When you click OK in the Traffic Manager, the Transmission Configuration
window reappears. The Back button is disabled, because the transmission
parameters have already been sent to the BTS. If you need to change any
parameters you have specified prior to this point, run the Undo
Commissioning procedure and then re-commission the BTS.

5. If BTS software is incorrect,

Then

BSC loads software to the BTS.

During the BTS/BSC start-up scenario the BSC checks the BTS software,
and if it is incorrect, the BSC loads software to the BTS. This process takes
between 5 and 20 minutes, depending on the link speed. The BCF is reset
automatically, which means that the Supervision and Alarms windows
disappear for a few seconds, but the commissioning procedure continues
after the BTS has started normally.

Else

If no software download takes place, the process takes about 10
seconds.

After that, the BSC sends the configuration data to the BTS.

6. Wait for the oven oscillator to warm up.

It takes a few minutes for the oven oscillator to warm up after the BTS is
powered on. If the oven oscillator has not yet warmed up, the BCF remains
in the Configuring state. The BTS Events list displays a message when the
oven oscillator is ready.
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7. Run TRX tests.

The TRX tests run automatically during BTS commissioning, or you can
run them manually. When the BTS is ready for testing, the Wizard
automatically proceeds to the next window, and the BSC runs automatic
tests on the Abis link and on each TRX installed in the BTS. For detailed
information on TRX tests, see Running a TRX test.

Caution

In order not to interfere with the operation of other sites, ensure an RF
attenuator is connected to every TRX in the BTS before you start local TRX
tests.

8. If there is no BSC connection,

Then

The Wizard asks if you want to use the software stored currently in the
BOIx unit memory.

If there is no BSC connection (the BCF remains in the Waiting for LAPD
state) and you click Next, the Wizard asks if you want to give the Use
Current command.

9. If you indicate you want to use the software stored in the BOIx unit
memory,

Then

Click Yes.

The BTS starts to use the BTS software in the BOIx unit memory and the
Wizard proceeds to the BTS Test Reporting window.
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Figure 140. Test Events

Else

Click No.

The BCF remains in the Waiting for LAPD state until the BSC connection
(OMUSIG link) is created.

10. Verify EAC inputs 1 to 12 in EAC Input Settings window of BTS
Commissioning Wizard.
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Figure 141. EAC inputs

a. Mark the required EACs as In Use.

The state of each EAC changes in real time as you test it. For
example, when you blow some smoke on the smoke detector, the
appropriate state changes from Open to Closed, or the other way
round.

b. After testing the EACs, mark them Checked.

c. When you have completed the testing (or verifying), click Next.
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Note

The Next button remains disabled until you select the checkbox for all inputs
that are marked In Use.

11. Verify EAC outputs in the EAC Output Settings window of the BTS
Commissioning Wizard.

Figure 142. EAC outputs

a. Verify the EAC outputs by changing the EAC states.

b. Mark the required EACs as In Use.
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12. Verify EAC inputs 13 to 24.

a. Verify EAC inputs 13 to 24 in the same way you verified inputs 1 to
12 (see step 10).

b. When you have completed the testing (or verifying), or if you do not
use these EAC inputs, click Next.

13. Verify EAC outputs.

a. Verify the EAC outputs by changing the EAC states. Mark the
required EACs as In Use.

b. When you have finished the EAC output settings, click Set Outputs
to send the information to the BTS.

c. After you have completed verifying, click Next.

Note

The Next button remains disabled until you select the checkbox for all outputs
that are In Use.

Note

EAC inputs and outputs windows are only for testing the lines.
Recommissioning is not necessary if new EAC lines are added later. EAC
lines are defined at the BSC, which activates the lines.

Note

The EAC names and polarities are defined at the BSC.

19.3 Defining Line Interface (LIF) settings of
transmission (FC E1/T1) units

Steps

1. Display the LIF settings.
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a. Click LIF Settings in the Set Transmission Parameters window.

Figure 143. Set Transmission Parameters Page - FC unit

b. The LIF Settings window displays.
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Figure 144. LIF Settings (E1/T1 interface)

2. Select the Interface in Use option.

3. Select the interface mode from the list.

4. If you selected the E1 750 ohm interface mode or the E1 120 ohm interface
mode,

Then

Define the TS0 fixed bits in the LIF Settings window for E1 120 ohm
mode.
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Figure 145. LIF Settings for FC E1/T1 unit in T1 mode

TS0 fixed bits 1 to 3 are reserved for CRC and frame locking. Bits 4 to 8
are used for alarms and data transfer in national connections.

Select the CRC in Use option the way it is defined at the BSC.

5. If you selected the T1 100 ohm interface mode,

Then

Define the Framing Format, Line Code and T1 Interface Type settings
in the LIF Settings window for T1 100 ohm mode of the UltraSite BTS
Hub Manager.
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Figure 146. LIF Settings window for T1 100 ohm mode of the UltraSite BTS Hub
Manager

6. Click OK to accept the changes.

19.4 Defining synchronisation settings of transmission
(FC E1/T1) units

Steps

1. Display the synchronisation settings.
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a. Click Synchronisation in the Set Transmission Parameters window.

Figure 147. Set Transmission Parameters page - FC unit

b. The Synchronisation window of the UltraSite BTS Hub Manager
displays.
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Figure 148. Synchronization Settings for FC E1/T1 unit

2. Set the timing.

Select the RX Clock timing option for Priority 1.

3. Click OK to accept the changes.
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20 Using the Macro Recorder

20.1 Recording a macro

Purpose

This procedure describes how to record a macro with Nokia AXC Manager. The
Macro Recorder function of Nokia AXC Manager can be used to record, store,
and run sequences of operations.

For instructions on how to run a recorded macro, see Running a macro.

Steps

1. Click Tools → Macro → Record.

The Record Macro dialogue box opens.

Figure 149. Recording a new macro

2. Enter the name and description for the macro.

The description field is optional, but it is recommended that this field is
filled.
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3. Save the macro.

Click Save As... and select a directory for the macro. By default, the macro
is saved in the File Storage directory.

4. Start recording the macro.

When you are ready to start recording the macro, click Start. The
recording control dialogue appears with the name of the macro visible in
the title bar.

Figure 150. Recording control: recording

When the Macro Recorder is recording, all operations performed with
Nokia AXC Manager are recorded in the open macro.

Note

An operation must be completed and successfully sent to the AXC by Nokia
AXC Manager before it is recorded in the macro.

Note

No software management operations, such as software download or activation
of new software, should be carried out during macro recording because of
differences between software versions.

Refresh, Inspect, Logout and Disconnect are not recorded in the macro.

5. If you want to carry out operations on Nokia AXC Manager that you do
not want to be stored in the macro

Then
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Pause recording the macro.

Click Pause to pause recording. You can now carry out operations that will
not be recorded in the macro.

Figure 151. Recording control: paused

Click Resume to resume recording the macro. Operations carried out are
now recorded in the macro.

6. Stop recording and store the macro.

Click Stop to stop recording the macro. A request to confirm the action
appears. Click No to continue recording the macro. Click Yes to save the
macro.

Figure 152. Saving a macro

7. If you want to delete a macro

Then

Click Tools → Macro → Delete.

The Delete a Macro dialogue box opens. Select the macro you want to
delete. The dialogue provides information about the selected macro.
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Click Delete. Confirm the deletion by clicking Yes.

20.2 Running a macro

Purpose

This procedure describes how to run macros with Nokia AXC Manager. The pre-
recorded macros can be used to run a sequence of operations in order to, for
example, commission Nokia AXC or restore its configuration after the hardware
has been reset. For instructions on how to record a macro, see Recording a macro.

Before you start

Note

When executing a macro, the configuration of Nokia AXC should be the same
as when the macro was recorded.

Steps

1. Click Tools → Macro → Run.

The Run Macro dialogue box opens. Select the macro you want to run by
clicking Browse...

Figure 153. Running a recorded macro
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2. Run the macro.

Click Run to run the macro.

Expected outcome

The macro is executed. A progress bar on the Run Macro dialogue box displays
the progress of macro execution. If the macro is executed successfully, the
message next to the progress bar changes to "Completed". You can see the new
settings after Nokia AXC Manager has performed an automatic refresh.

Unexpected outcome

If the macro execution is unsuccessful, a message box displays with a list of
errors that occurred during execution. The message next to the progress bar
changes to failed.
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21 Commissioning reports

21.1 HW configuration report

Purpose of the report

The HW Configuration Report is an ASCII text file (.hwr extension) that you can
open and check with any word processor. This report, along with theTransmission
configuration report and the BTS commissioning report, serves as the Site
Acceptance document. It is recommended to use the same filename for the
different reports of the same site.

Understanding the report

Table 9. Report fields

Field Name Description and possible values

Report title

Date and time

HW configuration filename Displayed if applicable

BTS configuration name Displayed if applicable

Cabinet information

BB2-TSx connection information

Cabling information

Antenna settings

HW information filename
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21.2 Transmission Configuration Report

Purpose of the report

The Transmission Configuration Report is an ASCII text file (.cmr extension) that
you can open and check with any word processor. This report, along with theHW
configuration report and the BTS commissioning report, serves as the Site
Acceptance document. It is recommended that you use the same filename for the
different reports of the same site.

Note

For UltraSite EDGE BTS installations using FXC Transmission units, you can
obtain the Transmission Configuration Report by choosing Tools |
Configuration Report | Save... from the Nokia UltraSite BTS Hub Manager.

Note

If there are no separate FXC transmission units in the BTS configuration, there
is no separate transmission configuration report. In this case, the FC E1/T1
transmission unit is configured during the BTS commissioning.

Understanding the report

Table 10. Report fields

Name Description and possible values

Report title . Equipment
. Date and Time
. User
. File used in commissioning

Node Identification . Equipment Type
. Equipment Name
. Family Type
. Site Name
. Group Name
. Site Location
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Table 10. Report fields (cont.)

Name Description and possible values

Node test report . Test Time
. Node Name
. Node Address
. Test Person
. Cross-connections

HW/SW configuration . Installed FXC units by slot:
. Unit type
. Serial Number
. Code
. Version
. SW version

Node settings . Service interface
. Q1 port address, speed and group address
. LMP address, speed and group address
. Q1 int speed and group address
. Control and confirmation timeouts

. Q1 management
. State of the Q1 hybrid switches

. Synchronisation settings

Alarm Configuration . All active alarms listed

LIFs and Flexbuses . Interfaces are listed and Flexbus capacities are shown

D-Bus allocation - D11-D13
(Traffic Management)

. Signal Timing mode

. OMUSIG

. TCHs

. TRXSIGs

. EDAPs

Cross-connections in active bank

Outdoor units . Radio measurements
. Active alarms in radios
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21.3 BTS commissioning report

Purpose of the report

The BTS Commissioning Report is an ASCII text file (.rpt extension) that you
can open and check with any word processor. The report includes test results and
configuration information. This report, along with theHW configuration report
and the Transmission configuration report, serves as the Site Acceptance
document. It is recommended to use the same filename for the different reports of
the same site.

Understanding the report

Table 11. Report fields

Field Name Description and possible values

Report title

Date and time

User name

Commissioning mode and network time

BTS logical configuration

Telecom status in TRXs

BTS HW versions

BTS SW versions

EAC input and output test

BTS test results In the test reports, each test gives one of the following test results:
. OK
. Partially failed
. Failed

Abis test results

TRX test results

BTS alarm test report

External TREs in Q1 port

Abis allocation report Available if an FC E1/T1 unit exists in the configuration
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22 Completing commissioning

22.1 Completing the commissioning

Summary

The configuration phase contains activities needed to make the node functional in
the network. These activities include the node ID, Q1, and synchronisation
settings for the node, unit-specific settings for the transmission units, radio
parameters, and cross-connection.

Steps

1. Browse the node off-line file.

Click Browse in the Site Selection window. Browse opens a standard Open
window where you can look for the file.

The Next button is disabled until a valid file is selected.
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Figure 154. Site Selection dialogue box

2. Verify that the selected site is the correct one.

Some of the node off-line file data displays in the Accept Site Selection
window. Click Next to accept the selected file.
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Figure 155. Accept Site Selection dialogue box

3. The BTS Manager compares the file equipment configuration against
the node configuration.

If there are differences, you are notified about them with the following
message: Fix the configuration and restart the commissioning process.

4. Send settings to the nodes and units.

After the configuration is correct, all the settings are sent to the node and
units. The UltraSite BTS Hub Manager takes care of the node level settings
and the integrated FXC unit managers take care of the FXC unit-related
settings and possible outdoor unit settings.

5. Monitor and fine-tune hops in the Check Hops window.
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In the Check Hops window, you can monitor possible radio hops and fine-
tune them. Only FXC RRI units are enabled. The UltraSite BTS Hub
Manager polls each unit and updates the status of the radio outdoor units to
the window.

Figure 156. Check Hops dialogue box

When you click Next, the polling ends, and the End window opens.

6. View the Commissioning Report in the End window.

A Commissioning Report is gathered containing the test results and the
node configuration information (node settings, settings of each unit, cross-
connections). The report displays in the End window. This report is then
protected and stored into a file which can be used, for example, for site
acceptance.
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Figure 157. End dialogue box

Note

After the first end of the hop is commissioned, the hop status in the Check
Hops window and in the commissioning report is shown as Not ready or
Trying, no far-end found until the first end of the hop is commissioned.

A complete commissioning report can be obtained after the far-end of the hop
has been commissioned.
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22.2 Powering down UltraSite EDGE BTS

Before you start

Familiarise yourself with the installation procedures for the additional site
equipment before powering down the site.

Summary

Warning

Risk of lethal voltages and electric shock exist when routing power cables.
Verify that the mains power breaker is off and that the unit is properly
grounded before attempting any connections to the unit.

Note

Follow all applicable national regulations when working with power supply
and power cables.

Maximum site downtime recommendations are provided by your Network
Planning Engineer.

Steps

1. Read the site downtime recommendations before powering down the
site.

2. Collect site equipment information.

3. Follow the powering down procedures of the relevant BTS or site
support equipment's user manual.
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